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INTRODUCTION

Image diagnosis techniques have become very important tools for the different medical
areas.

The ENDODIGI Digital Data Capturing System was designed to capture video, images
and sound.

The content of the manual describes the procedures recommended to install and use the
ENDODIGI. 1t has all the necessary information regarding the appropriate care and
handling of the equipment.

Should you have any doubt about the content of this manual or the operation or safety
of the equipment, please contact your local distributor or the closest ECLERIS office.

If in doubt, contact your service technician or local representative for help

ECLERIS USA

11801 NW 100th Rd
“ Suite 17

Medley, FL 33178, U.S.A.

Phone: +1 786 483 7490

info@ecleris.com

www.ecleris.com

CMC Medical Devices&Drugs S.L.

EC REP C/ Horacio Lengo N°18, CP29006, Malaga, Spain
Ph. +34951214054

Email: info@cmcmedicaldevices.com

The ECLERIS ENDODIGI has the CE mark, which shows it meets the
93/42/EC Directive from the European Council, related to medical

appliances. The MDD equipment classification is I.
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TECHNICAL SPECIFICATIONS

Equipment: Digital Data Capturing System

Model: ENDODIGI

Equipment class

Model

Standard Definition

High Definition 1080p

Video input Video in base band. HD HDMI Video Input
Equipment Connector: RCA
socket.

Video output None None

TV System NTSCy PAL 1080p — 720p

Interface USB 2.0 USB 3.0

Resolution 24 bits (RGB)

Definition Preview 1024-768 Preview — Video and Images
Still Image 640H — 480V up to 1080p 60 fps

Video 640H — 480V

Capture formats

JPEG (Images) - WMV9
MPEG4 Encoder (Video)
WMA 9.2 (Audio)

JPEG (Images)
MP4 — H.264 (Video)

Service conditions

+10 - +40°C(50 — 104°F)
30-75% (ambient relative humidity)
700-1060 hPa

Storage and transport
conditions

-30 - +45°C(-22 — 113°F)
10-95% (ambient relative humidity)
500-1060 hPa

Weight (cabinet )

0.2 Kg.(0.44Lb)

0.2 Kg (0.44 Lb)

Dimensions (cabinet)

9X3.6X2.2cm
(depth width high )

9X 3.6X2.2cm
(depth width high )
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SYMBOLS

(LB>O

+50°C
95% hum
1060 hPa

-30°C

Read the
documentation.

related

Attention!

Alternating current

Protect against water

This side up

Environmental
conditions

transport

Fragile

g X B

@)

Manufacture
identification
(Name, Address)

Type B

Do not discard with the
household waste

Serial number

On

OFF

Manufacture date
(MM/YYYY)
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USAGE RECOMMENDATIONS

This user’s manual is a part of the instrument and should be read before the installation.
Exact adherence to the instruction manual is a prerequisite for the perfect and intended
functioning of the equipment

Only personnel with proper training (skilled personnel) should operate the system
ENDODIGI.
If as a consequence of:

« Inadequate use of the equipment

* Poor care and maintenance of the equipment

* Repair and manipulation by unauthorized personnel
Any material or personal damage is caused to third parties, ECLERIS, the manufacturer
and the supplier of the equipment, shall not assume any liability for such damages

HARDWARE

For HD Device, see the section HD External Recommendations.

The equipment is not conceived for operation in potentially explosive
rooms or flammable atmospheres (anesthetic mixture with air, oxygen or
nitrous oxide).

Do not connect the equipment to a HUB USB and/or share the USB BUS
with any other active devices. This can cause data loss.

are not correctly assembled
You cannot use USB.

The ENDODIGI must be used with a medical grade computer. The PC
must be connected to an electrical installation correctly protected and
equipped with a protective earth.

The equipment should not be installed in the vicinity the electro medical
and/ or electrical equipment (X-ray equipment, motors, transformers),
since electric or magnetic interferences may affect its performance.

f If possible, do not use the front ports of desktop PCs since normally they
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SOFTWARE

A Read installation instructions before installing the equipment.

é Check in Control Panel/regional configuration/Number that the decimal
symbol is a dot “.” and not a coma «,”.

Do not turn off or disconnect the equipment if the software is registering,
A this will make Windows discharge the drivers whilst they are being used
and will produce an error. If this occurs, reset the PC.

To record real-time video or still pictures, the machine requires most resources,
therefore follow these advices:

It is recommended close all other applications to starting to record a
@ video. They usually slowing down the machine so that an unexpected
timeout somewhere may occur leaving the video interrupted. But if in
spite of close all currently running programs, you have trouble. Should
be disabling (NOT Uninstall) the following applications temporarily:
e Antivirus
e Disk defragmenters
e Index finders, especially Microsoft Indexing Service
(previously Microsoft Office Fast Find Index)
Task planners
e  Screen-state indicators Antivirus

@ Don't use the CD/DVD-ROM while videos recording

Hard disks reach their top performance when they write in sequence mode.
Random on the other hand, involves large numbers of seeks and rotations, and
is usually much slower:
Execute the disk defragmenter and check that free-space is not fragmented. The
existing files fragmentation is not important but it is important the free-space
fragmentation.
Always have extra free-space in the disk. The fragmentation worsens a lot when there is
only 5-10% free on the hard disk.

@ Keep the hard disk clean. Disk write is classified as sequential or random.
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ENDODIGI 'S OVERVIEW

SOFTWARE FEATURES

ENDODIGI allows you to capture videos in real time, still images (pictures) and store
sounds.

The simple installation and operation equipment, the exclusive remote system by foot
switch or wireless device and the user-friendly program allows use the ENDODIGI
without any help.

The database stores images, videos and sounds together with the patient’s clinical file.
The capture stored can be edited with image and video internal editor. Moreover, it
allows you to import and export images, video for a later edition and analysis on
another environment.

The system stores a pathologies list that can be associated to the patients. This can be
used to generate a simple statistic (not available in ENDODIGI Client) by pathologies.

The printing options are varied, allowing the selection of images to print, the quantity
of images per page, size, etc. ENDODIGI allows the user to prepare elegant reports and
to print with any printer.

You can create templates to fill out, that minimize the time when completing a report.

Is possible make web publications to share with patients and colleagues, reports, images
and / or videos over the Internet. You can also export reports to PDF and store it in a
physical environment.

The system also provides tools to do backup and retrieve data, protecting important

information on patients and its studies.

Version ENDODIGI- server: This allows to different users (client) accessing,
expanding and modify patient data in a single data base (server)
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GENERAL DESCRIPTION

The windows of the program were specially designed following an intuitive and easy-
to-use format. They are divided as follows:
e A Menu (up)
e  Atool bar (left) where the buttons allow performing different functions.
e A main area (center) where you can find buttons, labels, edition controls,
graphics, etc., to perform the study itself.
Specific controls (right) of each window.
e In the client version there is a status bar that describes the server state
connection and data transfers

Specific
controls

Menu

Digital Data Capturing System

cic

i
e

— 0 o0+

oo

Q
©QIC

Main Area

Minimum resolution is 1280 x 720 pixels. True Color (24 or 32 bits).
To change resolution settings, see: Advanced Options: Screen Resolution.
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RUNNING THE PROGRAM

Upon program startup, a patient chart is opened. Fill out a new profile and case history
of patient and save it.

If you cancel the patient chart, must open a new from to File=>New Patient menu. It
allows creating a new Patient Profile. To find an old Patient Profile must go to
database.

)

In the client version has the option to create privately Patient Files, which are not
transferred to the server.

MENU

FILE MENU

New Patient: Create a new patient chart. In the new file should be enter the patient’s
name and other data from study (optional). The date is auto filled out. Once the file is
completed, save the data to continue. To return to the main window, select

Patient data: To edit or add patient data.

Sound: Capture sound (See section: Working with Sounds)

Data Base: allows retrieving a file, which is already stored in the database for its
analysis, review or printing

Users: Manage the user’s data to access the software. (See Uses Management)
Statistical: to generate statistics by pathologies. See section: Performing pathologies
statistics. (Not available in ENDODIGI Server)

Print: Access to the Print Window. (See section: Printing Images and Printing a report)
Quit: Closes the program.
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EDIT MENU

Templates Builder: This function allows writing standard reports to save it as
templates. They will be available to be loaded to the patient’s file every time it is
desired. This option will allow the standardization of all patients’ reports.

Cropping: The Crop Tool is usefully to trimming dark areas. This is often used to
remove unwanted areas on your printings. It allows you to save time and ink. (See
section: Printing a report).

OPTIONS MENU

Languages: The ENDODIGI interface is available in English, Spanish and Italian. To
changes language, click “the selected Language" in the pull-down menu, and reset the
program.

Data Base Pathology: This database is an organized collection of Pathologies. The
data is typically organized for statistical purpose. See section: Performing pathologies
statistics.

Data Base Professional: Adding, edit or delete professionals from a list. See section:
Data Base Professional

Image Library: Allow creating an Image Collection (injuries, tests, treatments and
surgery procedures and human anatomy). They can be widely used to the patient
education and health care professionals or to build enriched reports.

Screen Setup: A "wizard" allow you to customize your window settings to fit the
screen desktop or use full screen setting.

Digital Setup: The digital setup allows selecting the ENDODIGI functioning mode.
See section: Digital setup.

Security options: options for managing user access and activities monitoring. (See
User Management session)

User management: add users individually or create work groups

Activity tracking: allows tracking the actions of users within the software.

Clear list of recent user: deletes the list of recent users.

Unknown user: Default general user is set, without key and global access. Disable
means that the software starts without a user default (unknown) and should login a user
to use it

Associate with window s user: Associate the Windows user (operating system) to the
current user Endodigi. WMI and net are two technologies to search the Windows user.

ENDODIGIWEB MENU

ENDODIGIWeb: opens a wizard to publish their reports, videos or images. To use it,
you need to have a connection to the Intemet and you must create an account. See:
Advanced Options: ENDODIGIWeb Publication.

INMANUUIN193Rev. 2022.03.28

14



HELP MENU

About ENDODIGI: Software version Information.

Remote support: User-friendly assistance for individuals having technical problems
with ENDODIGI. The technical support team is able to troubleshoot most problems
that a user experiences. Technical support may be provided, through email, or with
remote interface

HD USB 3.0 - Activation

@ Email
I

Start Important: Complete with a valid email. We will comunicate with you to this
email.

Serial number (is the number on the pendrive label)
Important: Complete. We use in case of activation problem.
O Automatical

C Using remote support.

Manual. It involves 3 steps, requires access to a PC with internet and request
for remote support from that PC.

Select an option and press the Start button

©

Back

TOOLBAR

New Patient: Load a new patient's data file.

Data Base: Allows search, retrieve and delete patient files stored, and backup
each one of them (See Data base — Patient Data)

Patient Data: Allows filling data gaps or changing and adjusting this data
(See Data base — Patient Data).

Main Report: (See Performing a Report) Allows create a main patient report
accessing to all banks. See section: Advanced Options: Templates builder.

Print: Access to print screen the reports and pictures, saved on different visit.
See: Printing a report.

€ dgdg e
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Sound: Sound recorder windows and working with sound. See section:
Working with sounds.

WEB: Access the exporter ENDODIGIWeb assistant.(See: Advanced
Options: ENDODIGIWeb Publication)

Quit: Exit the program
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STORING IMAGES AND VIDEOS
FOLDERS VISITS

The folders at right on main window allow storing image E]
and videos. From the functional point of view the users
can to work more efficiently and orderly.

Images
Videos
Reports

Open a folder, to capture video and / or images,
clicking on it (visit). Then a dialog-box will appear to
identify folders with name and date. (l.e. Name: Vocal
cords)

Name [fvisi 1 This facilitates the storage of images taken at different

times, thus enabling the assessment of treatment

Press \/ to accept or X to exit without saving.

pate 19072013 @-

After create a folder, you can add images or videos on it. The images and videos
quantities can be seen on the each folder bottom

To modify or rectify the Folder name and date, enter to the visit and select
general information.

Visit Delete: Deletes the visit with all its contents. The option appears when the folder
has been created. (Not available in Endodigi Server)

Import: If the folder has not created yet, the import option will be enabled.

It lets you add a visit that was previously exported from ENDODIGI by Export Visit
option.

Once you select a visit folder, a window to capture (image or video) is opens.

The session always starts in the Video Mode, to change it clicking on the Image tab.
The central viewer offers a preview of still image or video recorded.
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Video/ Image player

Digltal Data Capturing System

cio

©

~ 2o -0 o H
| |

0 60

Videos/Image Controls

Note: you can enter to capture in:
Image Mode: The footswitch is set up to capture images.
Video Mode: The footswitch is set up to start/end the video records
Video and image Mode: The footswitch is setup to record either video or
images according a time fixed

The ENDODIGI is installed by default with the "Capture sound" option
disabled because this option needs to be set. You can tum on this option from
"Options/ Digital Setup”. See Digital Setup
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CAPTURING STILL IMAGE AND VIDEO

e

S O T — 0 0o -

TOOLBAR

Pressing the button Capture (Video or images mode) will enters the
window that displays video signal in real time. This window has a menu
and a toolbar wherever allow you to set up acquisition, and you can get
both pictures as full motion records and storing them on the visit’s folder.

Menu
v
&

1-'3 Show: The screen shows the toolbar always visible.

Hide: You can hide the toolbar to create more space. The toolbar is hidden
from view. You can see it again by pointing to upper right

M
| Input: Show a window that allows select the input.

Record: Starts the full motion recording or the image capture. From below
dropdown menu, you must set the recording time, to each video clips.

When the Record button has been activated, it will flash until recording time

is reached, or until you press the Stop recording button.
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When ENDODIGI starts recording, the record button and the toolbar, blink
to denote that recording is in progress and the timer is start ticking.

B

min

This popup menu lets you select the limit time (in minutes) for the
recording a video. The selected time will be the default for the next

o > [ @

ige@p

record

Stop: This button allows you to end the video recording in anytime, even
before the ending timed.

Snapshot: Save the freeze picture on the current file.
Images #: Amount to saved images

The blinks button to denote that a new picture was captured and the
superscript number is a frame counter.

Hot key:
Spacebar: Analogous to Snapshot button.

Freeze/Unfreeze: Stop the video signal, so you can get a preview before
take a snapshot. To unfreeze the image video press the Unfreeze button.

However, you can later turn videos into photos by using Snapshot function
(See: Working with videos: Snapshot)

Target: add a grid, over the picture, whose aim is to plot areas over it. (See
Targets)

Back: returns to the Videos and Image window.

Overlay (HD External USB devices only): Displays full screen real time
video of the selected camera.

9

Q

=

3D 2D (HD and 3D USB devices only): switch between both

SO views.
2D
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MENU

SETUP
»  Setup->Configure Input: See: Video setup: Input.
»  Setup->Select Input Active: Select the video source to show.
*  Setup>Preview Resolution: Allow setup the screen display mode. See:
Configuration of visualization.
*  Setup->Footswitch:

Automatic mode: The footswitch will be on to videos or images record, according
tab (video/Image) input selected.

Video mode: The footswitch will be on to videos record:

1° Click = turn-on

2° Click= turn-off

Image mode: The footswitch will be on to image record. It is allows to take snapshot,
directly (each click) or by freezing/unfreezing the video signal.(See: Freeze image
before capture)

Video and Image Mode: In this mode the pedal is activated to work with both
routines capture, i.e. to record video and images as long as you stay down.—>Setup:
Set a time limit for trigger the footswitch in both capture routines.

Mode Chapters: In this mode the pedal is activated to record video and capture
chapters, depending on how long it is pressed. To do this, you must set the time to
work with both Routines->Configure: Set the time limits for the pedal to capture
chapters or video according to the set time (See Using the Footswitch).

Freeze Image before capture: When this option is on, the footswitch is ready to take
pictures. Pressing the footswitch once, the image is frozen while remains pressed.
When it is released, if you press the footswitch quickly without delay, the image is
captured. But if two seconds elapse without depression, the image will be unfrozen
without save it. If this option is disabled the images are saved each time you press the
footswitch.

Enable Sound: When this option is on, you hearing a Beep every time the Footswitch
emits a signal, for both to start or stop the video capture, as to freeze-unfreeze an image

e  Setup->Visit mode
Entering: Sets the display mode visit to join it.
= Image: Sign in Picture mode alone.
= Video: Sign in Video mode alone.

= Image and video: sign in both picture and video
mode

=  Preserve active: Enters in last mode used.

Exit Capture: Sets the Visit screen mode to return of capture screen.
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= Image: Sets the picture mode to exit.
= Video: Set the Video Mode to exit.

= Image and video: Set the both picture and video
mode to exit

= Footswitch: According footswitch settings. If it is
set to capture images then return to mode Picture.
Analogous for the footswitch is set in Video mode.
If the footswitch is set to Auto or Video-Image
mode then last mode used.

=  Preserve Active: the last mode that was selected
before entering the Capture screen is preserved

RECORD

+  Record->Start: Idem Record Button

+ Record - Loop: If loop recording is activated, implies the recording cycle is
repeats itself as configured. For example each 1 minute goes start a new video
clip, without you needs press start/stop again and again

* Record - Repeat Activate = Configure: Sets the cycle amount by a preset
time. This way, users will be able to take short time videos. For example: 3
Videos/ 1 min each

STOP: Idem Stop Button

FREEZE/ UNFREEZZE: Idem freeze /unfreeze Button

SNAPSHOT: Idem Snapshot Button.

REPORT: Open a report.

CHAPTER: Save a mark (chapter) at that time during the recording of a video.
BACK: Idem back Button.
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USAGE FOOTSWITCH

Footswitch for hands-free image capture, is the best option when you keep busy
manipulating others device controls.

If “Enable Sound" is checked, you will hear a beep each time the footswitch
is detected

VIDEO CAPTURE
« If you are not yet recording, press the Footswitch once to start recording

« If you are already recording, press the Footswitch once to stop recording

IMAGE CAPTURE
There are two ways to capture an image using the footswitch. Use “Freezelmage before
capture” menu to switch or toggle between the two modes.

e METHOD 1: Freeze Image before capture: checked: Depress the
footswitch to capture the image, release for a “live” image.

e METHOD 2: Freeze Image before capture: unchecked: Depress the
footswitch for freeze image, release and press again to save the still
image.

VIDEO and IMAGE CAPTURE

Set a time limit for video recording. (E.g. 4sec) automatically the image time capturing
is fixed as video time/ 3(e.g. 4/3 sec)

e METHOD:

Image:Depress the footswitch to capture the image, release it
before 1.3 sec.

Video: Depress the footswitch at least 4 sec to start video recording
and release it, then press the footswitch again for 4 sec to stop
recording.

Preparing t

@ To determine which way is more comfortable for you try them out.
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CAPTURE OF CHAPTERS AND VIDEO

Set a time limit to start / stop video recording (Chapter Mode Settings) (For example, 4
sec). The chapter capture time is automatically set to Time / 3 (For example, 4/3 sec =
1.3 sec).

* METHOD:

Chapter: Press the pedal to capture the chapter, release it before 1.3 sec
Video: Press the pedal for at least 4 seconds to start the video recording and release it,
press the pedal again for 4 seconds to stop recording

Preparing to start capturing video... Preparing to stop capturing video..
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TARGETS

A Target basically is a drawing that mimics a map to fit your screen selection; it may
display or hide grid lines and more. The target (map) may be a grid layout as a
checkerboard or concentric circles divided into segments, of equal size. Target offers
several handy and practical tools to facilitate your image analysis. Just look at the area
or quadrant of the target in question.

TARGET ACTIVATION

To activate one of the targets available, you must go to menu Setup =Target as shown
in the following figure:

et | eecors [ e =

Configure Input

SelectInput Active >
Preview Resolution
Foot Switch

Enabled Sound

lode

Target 1
Target 2

Create new ...
Delete Targets...

The target is not shown by default and needs to be enabled in the menu options:
Target_1 or Target_2. When you select one, it is draws in the display as shown in the
figure below. Established target is linked with the active video input. When you change
the video input, you must set up a new one.

[ .
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The "Configure Target" button at the bottom of the screen allows you to set the
current target. (See Configure Target)

The target associated with a video input can be visible or hidden. This property is
controlled from the Configure 2>Target >Visible menu. When the target is visible,
each picture recorded includes the target. It is no removed then.

CONFIGURE TARGET

The user can set up the Target properties, using the tools described below:

Name: The name is a tag to identifies the graphic picture (Target)

Image: Selection of the picture appearance (two options)

Size: Text box will resize automatically your image size. Also includes a slider so you
can control the size of the image.

Adjust: Enlarges/shrink the aspect ratio of the picture to fit the screen.

Horizontal: Modifies the horizontal position on the screen area. You can specify the
shift length to move the Target to the left (negative) or to right (positive). Also includes
a slider so you can move the image.

Vertical: Modifies the vertical position on the screen area. You can specify the shift
length to move the Target to the up (negative) or to down (positive). Also includes a
slider so you can move the image.

Default values: return the target to its original starting point (Size, Fit, and Position).

NOTE: All controls (size, fit, horizontal and vertical) have got an "x" button
that lets you reset to default settings

Save: Stores the settings combined of the new or edited Target.
Cancel: This option allows cancel all changes made in the current Target from the last
time that save them.
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NEW TARGET

To create a new target, you must go to menu Setup >Target >Create new...Then you
must assign a name and set others properties (See Configure Target)

DELETE TARGETS

If you want to delete any Target, you must go to menu Setup 2>Target->Delete
Targets... and simply select the target you wish to delete from the dropdown list and
click the “Delete Target” button.

CREATE A CUSTOMIZED TARGET

The software supports up to 10 target images. By default, there are two images
(Target_1.png and Target_2.png). To create your own customized target image, you
must follow these steps:

1.

Build up a square image (aspect ratio width: height), 32 bit, with transparency
and PNG format. (It's recommended you provide a resolution 720x720 pixel
so the image retains the best possible quality).

Save the picture in PNG format (i.e. the name will end in .png) in the Targets
folder. It is the "TargetGinec" folder inside the working directory
ENDODIGI)

The customized image filename must be "target X.png"”. Where X
represents the Target index, whose valid character is the sequential numbered
1to 10.

After adding a target-picture, the image will be displayed next to Targets list
in the image panel. When you click a tagged picture (i.e. target_3.png) will be
available for apply.

INMANUUIN193Rev. 2022.03.28

27



WORKING WITH STORED VIDEOS AND/OR
IMAGES

Video/ Image displays

Digital Data Capturing System

f

MO

g

—

(a1} =

= O T — O O

Video or Image Controls

The whole set of pictures or videos are displayed in the quick view grid. This can then
be helpful when you have multiple shots of the same material, to select the best digital
image. It is capable of displaying up to 25 pictures by dividing the display into grids of
5x5 of a fixed size.

There are different layout styles available to suit your specific working needs:

u u
o o
9 9
v v
o v
- ©
o v

2x2 3x3
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To enlarge an image or playback a video, simply double-click on it.

General information (%

Visit All images, videos and reports made.
4072017

Export visit: Displays three options:
| Export Visit

Images: 7/ 99

Reports: 1/ 20

e  All: Allow export images, videos, reports
Videos: 13/ 20 e Image: Only allow export image contained in the Visit.
e Video: Only allow export video contained in the Visit.

Click on the option you want and select a folder where going to saving the visit.

You can also set the display mode from the option menu and can
select view only images or video, or both. And you may also
order them (newest or oldest first)

The text box at the bottom shows a comment about the content
(image or video) selected. The comment by default is record
date of the selected image/video, but may be replaced by a
custom text. In the case of images, the comment may be printed
together to picture. If you export image (or videos), then these
are also stored with the original file, as .txt file

To the right corner, there are synthetically information of the bank.

Vista actual - Opciones

Vista actual
@ Imagenes y Videos
) Imagenes

°) Videos

Orden Lista
©) Mas nueves primero

@ Mas antiguos primero

Informes

1Y)

The program allows you to create multiple reports (up to 20

Report 26/04/2016 10:17:156

reports) associated with same visit. Report 2610472016 10:16:4

To create new report,press the button and the
@ screen report will open. All report(s) created are
displayed in the list.

Report 08/04/2016 10:52:42
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This button activates the selected report in the list (red font). By default, the
program selects the last report created as asset. It will be available to print,
export or upload to the web.

Export DICOM: Allow Export report to DICOM, contact technical support to
allow this feature.

VIDEO /IMAGE TOOLBAR

17 =
©

@

Fﬂ‘

€ €0 €

Capture: Accessing to recording images and Videos (See section: Capturing
still image and video).

Import: Allow import Images (only on image mode) (See section: Import
Images).

Export Images / Videos: Allow export Images and videos (See section:
Export Images / Videos).

Web: Opens a wizard to publish their reports, videos or images. To use it,
you need to have an internet connection and you must create an account (See:
ENDODIGIWeb Publication).

Report: Allow create a report in active setting (See Performing Report).

Print: Opens the printer preview to print the reports and corresponding
images in relation to visit (See: Printing a report).

Compare: opens the window “Compare” that allows the image or video
comparison from different visits and different patients (See section: Compare
Video, Compare Images).
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THUMBNAILS
Thumbnails allow you to select the content to which you want to work.

Small icons on the thumbnail indicate that the content (Image or Video) has been added
to the list corresponding to the icon (Export, Print, etc.).

Image:

Video:

Context Menu: See Working with Videos — Video Toolbar/shortcut menu.
See Working with Image — Image Toolbar/shortcut menu.

For easy handling to images and videos, can be selected and dragged directly
from your monitor with touch or mouse (Drag and Drop) to any buttons such
as Export, Web, Report, Visit, Delete, Compare, and Edit.

@ Use the keyboard to improve navigation through thumbnails:

Hot Key:

Arrow keys: Use to move Left, Right, Up or Down through the thumbnails.
Home Key: First thumbnails

End Key: Last thumbnails

Spacebar or enter key: Thumbnail selection
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CONTROLS VIDEO/IMAGE

D _ :
‘ﬂ Delete: Erases the image or video selected.

O Edit: Opens an Image or Video editor, according to currently selected tab.

Image editor: can be used to add different shapes (marks) in a picture and also add
your own text or tags over a picture (See: Internal Image Editor).
Video editor: can be used to trim a video clip (See: Internal Video Editor).

Detail: Enlarge the image and create a new image zooming
Detalle

Photo: saves an image as photo's patient, and then may be printed on the
report header (Only Image Mode).

6 6 Scroll forward/backward on the thumbnails
Pathology: Patologia E

On the clinical visit can relate the images (videos) || \5251%

of the bank with different pathologies. Peptic Ulcers

To attach a pathological condition, press the button inside the box and if it is
available a list is opened.

@ To add pathologies on the list: See Create lists pathologies.
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WORKING WITH VIDEOS
VIDEO TOOLBAR/SHORTCUT MENU

When you click the right mouse button on the selected picture, appears a popup menu.
It offers a limited set of functions whose actions are related to the selected object:

Use this icon to access to the contextual menu in touch-screens

To Export: The selected video can be exported by pressing “To Export”. In the

thumbnail appears a respective icon (@) indicating that it has been added to the list
of exported. To remove it from the list, you must reselect it and press “To Export"
menu again. No icon indicated that the video has been removed from the list. . (See
Section: Working with stored Video and/or Images: Export images/videos)

you can send one video from visit #1 captured in 05/01/2007 and two videos

The videos sending “to export” may belong to different visits. For instance,
@ from visit #2 captured in 10/12/2007

To ENDODIGIWeb: The selected video will be adding to ENDODIGIWeb list. At

bottom of image appears the respective icon (@). To delete from ENDODIGIWeb
list, press again TO ENDODIGIWeb (See ENDODIGIWeb publication).

To compare: send a video to “Compare” window(See: Compare videos).

Export: Idem Export button. (See exporting Video/image)
Edit: Idem Edit button. (See Internal/external Video Editor)
Delete: Idem Delete button. (See Controls Video/Image)

Use drag-and-drop to move videos to new windows, such as Compare, Edit,
and Export. It makes operation simpler than using the short cut menu
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VIDEO PLAYER

Double click over the video thumbnail, on the visit screen, it will playback the selected
video.

Image counter

Vocal Frequency

Strip Images

Zoom preview

Speed control

Snapshot preview

The chapters captured in the video clip are shown in the chapter strip and can be
deleted. Thumbnails view can be hidden.

THE SNAPSHOTS TAKEN IN THAT VIDEO CLIP ARE SHOWN ON THE
RIGHT SIDE OF THE SCREEN. THE THUMBNAILS CAN BE HIDDEN OR
MOVED, OVER THE PLAYBACK SCREEN.

(See: Digital Setup - Capture Sound.)

@ When playback a video recorded with audio the vocal frequency is shown.
Vocal frequency is not available on video captured with HD Device

PLAYBACK CONTROLS

@ Play/Pause: It reproduces the selected video / temporarily stops the video
playback until you press Play again.
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Forward Frame: It allows to move frame by frame to get a clear snapshot.

Backward Frame: It allows rewind the video frame by frame to select the
best snapshot.

Loop: when the video reaches its end, it will immediately start playing again
from the beginning.

Zoom: Increases sector video and displays a window to control the location
and increased sector.

Snapshot: You can take a snapshot with a click of button. To enable it, pause
the movie and scroll the video frame by frame (Forward/Backward) to get a
more accurate shot. The new snapshot is displayed on the preview capture
windows. The trash basket allows deleting and the hand confirm it before reaching the
configured time, and then the frame will be saved.

< @@ e

Edit: opens the video editor to trim the start and end of it. (See Section:
Internal Video Editor).

Sets display: (See Section: Configuration of Visualization)

€@

3) Audio: Used to raise, lower or mute the background sound. Place the cursor
| inside the box to increase or decrease sound or click on the loudspeaker to

(} _- h

Close: Closes the enhance playback mode, come back window.

Use the keyboard for easy playback
e Esc key: exit

© @1

e Space Bar key: take a Snapshot: Analogous to Snapshot button.
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COMPARE VIDEOS

@

Compare: You can send only two videos to compare (use shortcut menu or
drag and drop function) that may belong to different visits and different
patients. Once you select the videos, click on “Compare” button to open the

clips simultaneously.

To compare them maximize the window. The videos can be played simultaneously
(play button toolbar) or independently (video play button).

To move them within your screen, click on the top border (title) with the left mouse
button and, keeping it pressed, move the windows to the desired position.

Remove the video, by closing the video player or by clicking in button.

TOOLBAR

v o € © € ©

Compare: Maximizes the displays to compare one clip to another and catch
the differences or coincidences.

Sort: sorts the displays on full screen mode (half and half).

Play: Playback two video clip simultaneously.

Pause: stops the both videos playback.

Snapshot: Gets two pictures, one for each video clip the superscript number is
a frame counter.

Back: exits the window.
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VIDEO EDIT

Edit Video: Clicking on Edit button, the current video will open on the video
editor

INTERNAL VIDEO EDITOR

It is a simple video editor, used to trim the beginning and/or ending of the video.

Trim clips allows you to modify the start and end points (and therefore the size) of any
video. When trimming, you can set the cut points start and end. The first determines
when to begin playing the clip, while the second determines when to end playing the
clip.

When you trim a clip, the frames are removed, so that the unwanted parts are lost
forever.

Initial trim

O0001467) 00405 164

The end trim identifier

Trimming a video clip:

Click Play button and then pause the video at the point you want to cut it. Then fix trim
point (red), by pressing the button.

-Or-
On the screen, move the trim slider to the point where you want to remove.
To remove the trim brand, press E button

—

v|

Repeat these actions to trim the video end (blue buttons).
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When you fix the trim points (red, blue or both), press Trim button.

A Trim summary is shown. It is include record times of the original and edited video.
You can accept or cancel.

WORKING WITH IMAGES

Zoom / Detail: Double-clicking on an image (or pressing button Detail) a new window
is opened. From this window you can change smoothly from a long shot to a close-up
or vice versa and take a new screenshot of the selected image area, it which will be
stored in the bank.

Controls Bar

Zoom

E Take an snapshot

# Pictures/ total pictures

IMAGE TOOLBAR/SHORTCUT MENU
When you click the right mouse button on the selected picture, appears a popup menu.
It offers a set of functions whose actions are related to the selected object:
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D Use this icon to access to the contextual menu in touch-screens

To print: Adds the selected picture to the image list to be printed. Print: the selected
(active) image, you can be send to the printing section pressing “To Print" button or
using the contextual menu (right mouse button).

On the thumbnail is displayed a printer icon indicating that the image has
-: been added to the list of images to be printed. To remove it, you must select

image again and press "To Print" button again; when the printer icon
disappears means that the image has been removed from the report be printed.

the thumbnail appears a respective icon, indicating that it has been added to
the list of exported. To remove it from the list, you must reselect it and press
“To Export" menu again. No icon indicated that the image has been removed from the
list.. (See section: Working with Stored Video and/or images: Export image/videos)

- To Export: The selected image can be exported by pressing “To Export”. In

c

The images sending “to print” and/ or “to export” may belong to different
visits. For instance, you can send two images from visit #1 captured in
05/01/2007 and three images from visit #2 captured in 10/12/2007

<)

@ To ENDODIGIWeb: The image will be sending to ENDODIGIWeb wizard

(S to publish. Add images, clicking on the right mouse button over the image
selecting. For more information see ENDODIGIWEB Publication. The
image gets queued on the ENDODIGIWeb, until final post is published

r

To compare: load image on the “Compare” window. (See: Compare Images)
Export: Idem Export button (See Export Image)

Export ENDODIGIWeb: Idem web button. (See Controls Video/Image)
Edit: Idem Edit button. (See Internal/external Image Editor.)

Delete: Idem Delete button. (See Controls Video/Image)

Patient Photo: Idem Photo Button. (See Controls Video/ Image)

To clipboard: It is used for copying the Image to clipboard for further use
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COMPARE IMAGES

Compare: Clicking it opens the window Compare Images. You can compare
|@ up to six images that may belong to different visits and different patients.

The images must be dragged and dropped towards the Compare button, or using the

context menu “To compare”

The superscript number is a frame counter.

Imagen Field

Image to compare

Usuario: UNKNOWN ()

Compare window

On the window maximized you can move the images to other positions and change

their sizes with the toolbar buttons.

To select an image, just click on the center of the image.
To move the images, drag them by clicking on their center and without releasing the
Mouse, drag them to the desired position.
Then, press the toolbar button you wish to be able to change their state (Clean, Enlarge,

etc.)
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TOOLBAR

Sort: orders the images on the left of the window in the original order.

X1/2: reduces the image to half its size.

X1: resets the sizes.

X2: doubles the image size.

Clean: removes the selected image.

Clean all: remove the images, releasing it to do other comparisons

Auto arrange: Automatically arranges the panels side by side.

,
I

Back: exits the window.

To change image size you can do it, with the toolbar buttons (x1/2, x1, x2) and then
drag and drop the image on another screen location. You can also resize the image by
dragging the picture corners.
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INTERNAL IMAGE EDITOR

It is an easy- friendly and intuitive image editor . You can use it to add different shapes
in a picture and also add your own text or measure in your picture

T
OO G000 IH & & - - B

9

Click on the ready-made shape. Available shapes include arrows, circle, and rectangle.

Position the pointer on where you would like to insert shape. Click and drag the pointer
to draw the shape to the desired position.

Modify shape's outline by selecting the thickness on the dropdown menu and change
the shape's color by selecting the color clicking on the "Colors" box.

Use Text to enter text in the picture. To resize and move the text box, and change the
font, font size, and text formatting you must clicking inside the text box within the
picture.

Save the edited picture and use it to do report and other things like that.

change its properties.

Save: Save the Image edited in folder of visit
Cancel: Cancels edition and returns to the Image windows

@ To change the appearance of some shape or text box, select it and then
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TOOLBAR

Shape:

oCircIe

D Rectangle

o Right arrow

¢' Left arrow

ﬁ Up arrow

O Down arrow

Use them to make shapes. To draw a
shape, click and drag with the left
mouse button. The fore color will be
used for the outline.

I Vertical ruler

Use the rulers to measure an object
length in your pictures

H Horizontal Ruler

A= . .

=Text Move the cursor in the drawing area to
the location you want to insert text,
click and begin typing.

L Font Open font face, size and style common

dialog to adjust the appearance of the
text.

1h Transparent background

The transparent or coloring
background. These options are only
available when there is a text box.

“ Select (Shapes, Rulers, Text)

Selected items

Delete (Shapes, Rulers, Text)

Erase the selected items

Fore Color

The Color box indicates the current
foreground color. To change the color,
click an available color square

Background Color

Select the text background color

Thickness size pull down box

The number determines the thickness of
the line stroke
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MEASUREMENT SCALE

Use this tool to set a measurement scale.To achieve the parameters of image
measurement system, the calibration is implemented by acquiring the corresponding
relations between the real world coordinates and pixel coordinates of pattern Image
(planar gridding) captured by your camera.

You can use a paper grid (Engineering Graph Paper, whose scale is: 10 X
2mm or 1 per inch) or an object of known dimensions, for instance a ruler.

T T T R L |
1 2 3 4

Points / Inches

10x2mm

Take a picture a part of known dimensions in the focal distance to work, and then
define its dimensions.

Select the Ruler
e  Horizontal ruler
e  Vertical ruler
Then draw the ruler to set a measurement scale
Logical length
Logical Unit = cm/inch

Then press “Save” your scale button

You must recalibrate each time you change camera or optical arrangement
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EXTERNAL IMAGE EDITOR

by default). See Options=>Digital Setup ->General=>Image: Use

ﬁ This editor is available if it is installed and has activated it (it is disabled

External Editor.

When you've made your changes, close the editor. Then the new picture will be updated

in the image viewer automatically.

If you are editing an image for the first
time, you must choose an Image editor
that supports pictures in JPEG formats.
The dialog box shows the programs
available to select.

Open with

Choose the program you want to use to open s fle:
Fle:  magen.edtinage
3=

Mcrosoft Wevel Stuc Version Selector (T M
oD wi

) toteped af pant

Q QuickTime Player

M VLC media player
-

4% Wndows Live Photo Galery 9 Wincows Media Center

Type & descrpson Siat you want to use for $his knd of Sle:

7] Almeys use the selected progrem to open the kind of fle

S|

The option "Always use the selected program to open this kind of file” must be actives,
so it will be the predetermined editing program

- Image Then press Reset Link External Editor button. Then select a

f To change the Image Editor, go to Options=>Digital Setup = General

new Image Editor as the first time.
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IMPORT IMAGES

T Import Images: Import customer images (jpg. or bmp. format) from
@ CD/DVD, USB drive, network drives, etc. Press Import button to explore
different units and files.

Image to Import Directory /Folder

Digital Data Capturing System

-~ 9 T —O0O0H

The image gallery shows small previews (thumbnails) of all of the pictures in a folder
at once. This makes it easier to quickly browse through large collections of pictures. To
show the image gallery, click to directory/folder. If the automatic option is checked, the
image gallery is updated every time changes the directory or folder.

Double Click on a picture in the gallery to enlarge it and click again to restore it.

To add images to the visit, select the image by clicking on it and then press the Import
button

To return to the backward window, press Back button

You can insert image saved in "My Computer", in the Image Library or in another visit
bank
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EXPORT IMAGES/VIDEO

m Export: You can export the image and/or video files. The videos are exported
ﬁ in WMV format (Windows Media Video) and the images in jpg format.
Actions:

v' Export one: the current image/video select (click on) is exported to a specific
destination pressing export button

(£ O

[/] Create directory structure Space Required(Kb)  Free Space(kb)

[v] Make subfolder ID info for EMR l B2 140124 527,74

v' Export a set (Images and/ or videos): Select a thumbnail and press the button
or Shortcut menu "To Export”. Once you have finished selecting them, you
could export all files pertaining to the instance using the “Export” button at
the standard toolbar left.

Export Options.
© visits

Current visit Videos
Images
2L @ Images and Videos
7 Remark
File Names
Standand
Generste filename from patient data
@ 1D infa on filename far EMR.

ok

Size(Kb) Remark s Date
30/08/2013 11714

Name Size(kt) Remari visit oate
¥ 09032013 BC..  38.945 Vides 08/08/2012 08:45 AM visit 3 30/08/2013 12:141..0

0 213 Egen =

| Create diractary structure Space Required(Kb)  Free Space(kh)

[¥] Make subfolder B info far EMR | R | A

Once you have selected the destination directory is shown how much free space is
available on the device, and how much space is required to export the file selected.

The required space is the maximum estimated value because the final value
will depend of the file compression
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Export Options:

All Images and videos send "To Export" are listed here. You have the option to choose
one or all them. By default, all elements are selected for you, unless you want to keep
out some of them check the box next to each item to deselect them.

The Export list shows the name that will have the file. Moreover, the size in KB,
remark, name and date of the visit to which it belongs.

To make easier to selection, use these options:
Filters:
Current Visit: Selects the items (all images and videos) belonging to the last open
visit.
All: Selects all images/videos in full listing.

Videos: only videos
Images: only images
Images and Videos: both images and videos.

v Remark: If this option is enabled allows exporting the comments associated
with each image/video in txt format. If this option is enabled allows exporting the
comments associated with each image/video in txt format. It is create text files with
the same name as the image file in question. For example: a picture called Nose.jpg
creates a file called Nose.txt.

File names:

Standard: The file is named as follows:
e -Endolmage+Bco+ # .jpg.
e -EndoVideo+Bco+ # .wmv

File name: Generates a file name defined by user which is formed from separate preset
labels.
The user may create labels using dataset

Pressing )

You can combine different tags to create a file name

(For example: CURRENT_DAY_ (YYYYMMDD)+
PATIENT CHART+PATIENT NAME= 20160302_3526_Smith.jpg)
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Filename Format

CURRENT_DAY_YYYYMMDD CURRENT_DAY_YYYYMMDD
CURRENT_DAY_MMDDYYYY PATIENT_CHART
PATIENT_LASTNAME PATIENT_NAME
PATIENT_NAME

PATIENT_CHART

PATIENT_ID

VISIT_DATE_YYYYMMDD

WVISIT_DATE_MMDDYYYY

VISIT_NAME

KEYWORD

Separator ||

Destinity:

Generate file name from patient data: The Exported file will be renamed with the
visit name plus the patient data. Format (.e.g. Visitl_Smith_John_BCO2V3.wmv )

ID info on filename for EMR: To all exported files will be assigned the name in EMR
format

Create directory structure: It can automatically create a folders structure in
destination directory. The folders name is the visit ID and images and videos are kept
separately.

Make subfolder ID info for EMR: If this option is activated, all export files (Videos
and image) will be assigned the name in EMR format.

Export to Dicom: Allow export to Dicom, contact technical support to allow this
feature.

To export only press the Export button and wait for the process to finish. And click Exit
to return window back

v Select All / Uncheck All: Select/Deselect all items listed.

Clear: Cleans the Export list.
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WORKING WITH SOUNDS

disabled because this option needs to be set. You can turn on this option from

@ The ENDODIGI is installed by default with the "Capture sound" option
"Options/ Digital Setup”. See Digital Setup

This section is not available for HD Device.

Enter the Sound section from main window. Similarly to the image/video capture
window, this one has the toolbar on the left, the sound files (bank) on the right and the
sound recorder controls on the center.

Sound

Digital Data Capturing System

!
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Back

Controls
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SOUND RECODER CONTROLS

@ Record: Records the sound for as long time preset

@ Stop: Stops the sound recording or reproduction before the default time is
over.

@ Play: reproduces the file sound selected.

On central you can see the sound plot. The record is shown in real time.

The sound files are automatically saved on first empty file and it can be identified with
aname.

selected sound file. You can select them, by clicking on bank or changing the

@ The pull-down menu number on the top right corner corresponds to the
number drop down.

TOOLBAR

Export: To save a sound file to other units (files, CDs, etc.). The sound
recorded is exported in AVI format.

Delete: deletes the sound stored in the selected visit

Speech Lab: Contact your local representative to activate the voice
laboratory option.

Sound Input: Open a window to select the input source. (See Audio Input)

D@ @ €

2
Lf

Back: returns to the main window.
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PATIENT DATA-DATA BASE

LOADING A PATIENT

The Patient Data button allows accessing the patient’s File where you can edit or add
data.

Patient Data

Digital Data Capturing System
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Comments

The Comments field is a section for free use that allows information storage for a
particular patient.

The Request field links a Medical Doctor from List of Professionals. Pressing the
button right side, you will see the address book of professionals. To add more contact,
see: Database Professional

Clicking on Patient profile picture, you can import a new image from a visit, library or
units Pc (See: Import Images) and to delete it click on Clean button

Access: Set the patient access (available in ENDODIGI Server version).

Private: The patient will be available in mode private.

You can configure the required field to enter a new patient. See Digital Setup
- General.

TOOLBAR

Save: Saves the patient’s data in the database.

> 4| Cancel: Ignores any changes in the form.
A4

9| %)
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RETRIEVING A PATIENT FROM THE DATABASE

To recover a Patient-File already stored, just press the Data Base button of the main
window and you will access the Data Base window.

Patients List

Digital Data Capturing System
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Search Controls

Patient Data

The database can be sorted (ascending / descending) by last visit date, Last Name, First
Name, or Chart # and Date, clicking on the corresponding field.

The selected file will be highlighted. The lower left section represents the patient data
profile and visits stored.

When one of these patients is selected for loading, you must press OPEN button or
double-click on a grid. Immediately images and videos are loading.

To search a patient, use filtering by First Name, Last Name or Chart #.

Upper side the profile patient, is shown the list of patients which match the current
selection criteria.

@ Historical: Displays a list of prints made, and shows the corresponding
. | printed report preview
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TOOLBAR

Open: Opens an selected patient’s file

Delete: Removes files from the database (videos, images and other data
related to the patient).

Backup: Allows backing up patient data and files (Video, images...) in other
folder/disks. See: Making a backup.

Restore: Allows recovery lost or deleted data via an old backup, also helps to
import patient data from backups made on another ENDODIGI version. See
Making a Restore.

c gEgie

View (available in ENDODIGI Server version)
Server Patient: Show the server patients List.

Private Patient: Show the private patient list.

OFFLINE PATIENT
(Available in ENDODIGI Server version)

You have the possibility to work off-line mode on client PC. (Server disconnected).

It can occur for many different reasons: network connection faulty, server downtimes,
PC off-line, etc.

If you are working on-line and lose server connection, the patient will be locked. In
these cases you must reset the connection, or add a new patient off-line.

Whenever you create a new patient without connection, a message is shown to save it
as off-line patient. If you accept, it is saved on off-line database. These files can be
transferred to the server once the connection is reset.

When ENDODIGI starts up or you press database button, the off-line database is
opened so you can manage files saved on client PC.

A You must be connected to a server before you can transfer files.
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Patients OffLine

First Name o Chat &
Test

O

L] Transfer: Sends data by client to the server

&)

Open: Loads the off-line patient selected.

r-
A

™\
X

Delete: Remove the off-line patient selected.

&

Cancel: Close the screen.
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PERFORMING A REPORT

INTERACTIVE REPORTS

The interactive reports allow you to just fill the available options and add text in the
blocks allocated for it. The template report is selected from the report dropdown list
(See Template builder)

Complete the choice or text and Save it.

Digital Data Capturing System

@ SPEACH-LENGUAGE PATHOLOGY DATA ADDENDUM
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I Current Page: 1 Number of pages: 2 Report Templates I____ - I

The row at the bottom of a window that displays information about the document, as
page current, amount to pages and dropdown text to select templates.

It is possible to call different report template to reports each particular visit.
List all: Loads all templates created in all languages.

TOOLBAR:
O

@| Save: Saves the patient’s report

Lx ! Delete: Removes report from the visit
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To Colloquial-To Standard: Only question blocks are converted to editable
text box equal to the block size. The text box contains the selected answers
and question. You can edit the text inside the block area.

If you make changes in Colloquial mode and returns to Standard mode,
consider that the changes made in this way (within a block) affect
colloquial text corresponding to the block (the text can be erased). The
questionnaire will be saved in the last chosen mode.

Preview: The preview button displays a preview of the entire document

Web: You need a few clicks to publish and share your reports with patients
and colleagues. Just fill the email for every person you'll include. Each
person you invite gets an e-mail message with a link.

PDF: Printing on .pdf format

Back: returns to the back window.
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PRINTING IMAGENS

To print the selected images of a Visit, you can do it from the To print pop-up
menu or by dragging the images with the mouse (Drag and Drop) towards the
Print button. Then press the Print button and you will access the print screen where you
will find the selected images.

Usuario: unknown @
Digital Data Capturing System

This way, even if it had selected pictures to print from another Visit, will be available
only images from the current Visit. The print report date will coincide with the current
visit.

To print a Visit Report, from the Visit main screen, press the Report button

and a Report Print Preview screen will open with the Report previously
selected in the Visit. Then press Print.

6 It is also possible to print previously selected images from multiple

visits. To do this, use the Printer button that appears on the main
screen and you will access the print preview screen.
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Digital Data Capturing System
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Print Preview Screen

Here you can select the number of copies you want to print and the printer to
use.

The entire layout of the document cannot be changed from here (See Creating
Templates).

Document to print

Digital Data Capluring System

QT 00+

Printer options
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TOOLBAR

Print Page: send to print current page of the document.

Print All: send the entire document to print (all pages)

Printer Open Printer Setup dialog box to setting page margins, and also select
a printer and its properties.

U € €

The setting margin does not apply to report Templates and its uses. This
@ setting will be applied to all image report pages.

o After you run a report, you can export it to PDF format.
Sk Export a report to do the following:
-Save a copy (all or some pages) of the report as another file type. (All/Page

option)
@ -Print the report in a different format and then print it. (PDF button)
-Work with the report data in another application as ENDODIGIWeb (WEB

Button)
During the data transfer, the display shows a progress bar.

The first time you do any of the two operations will be automatically
installed the necessary drivers to convert. A window will be shown that
this process is being performed.

This process may take several minutes to complete if you have a lot of
image. ENDODIGIWeb shows a message that the process has been

At Sharing a report in ENDIGIWeb, be careful not disclose private info.
A warning message, alert you to actions that you be taken.
A completed successfully.

1)

J Back: returns to the previous window.

Q
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PRINTING OPTIONS

Header: A report can contain a header that run along the top of the each page,
respectively.

Add Pages to Personal Information: Add a page with personal information of a
patient. It is address, phone, pathologies, etc.

Report: allows printing the Report of the study performed.
Banco 1

If the option is marked, the report previously made in the Bonca 2
patient’s file will appear on the first page.

Visit Report: This option calls the “Printable Reports”
window. The report for each visit goes to a common list,
where you can select them to print in paper form, export in
PDF format or share electronically on ENDODIGIWeb

To select/deselect a report, activate or deactivate the
corresponding box, by clicking on it

Then Quit and the changes will be shown in the preview.

Photo: If you activate this option, the image saved as Photo will be printed on the top
right corner of every page.

Images: Prints those images that were not sent to print from the visits. As regards

image printing, you have the following options:

The user will be able to print image, previously selected from different
A Visits using the To Print button

Cropping: Applies the cropping area to removing the dark background (See section:
Cropping areas).

Image with Border Image without Border

Remark: Attached at the bottom of a page, the image tag or comments, those have
been previously created. See the section: Working with Image
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Images/Page: This option allows organizing the images in the page according to the
distribution selected in the scheme: 1, 2, 4, 6, 12 or 20 images per page. For instance, if
you have 8 images, it is possible to distribute them: 1 image per page bringing the total
to 8 pages to print or else 4 images per page bringing the total to 2 pages. The size of
the images varies according to the selected scheme.
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ADVANCED OPTIONS

TEMPLATES BUILDER

In the main screen, form Menu->Edit>Templates Builder. You will access an easy-
to-use interface to design the questionnaires and does not require any programming

knowledge.
You can fully customize the quiz layout. It is includes a variety of answer schemes, as

Multiple Choice, Drag and Drop Matching, Fill-in-the-blank, add images and others.

Digital Data Capturing System
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You can design or modify templates.

Reports can be saved by grouping them into categories, either by specialty, pathology,
etc. For example you can have the category ENT, Gastro and Surgery. Within each
category you can create different templates.

To edit, add or delete categories press Edit button.
To set a template as default press Set as Default button. So it will always be available

to complete the reports from the visit.

To import a template (.rds format), you must select the category where you want to
store it and then press the Import button. It will display a window where you can

search a file to import.

You can also set a header for reports. To do this, press the Show Static Pattern button.
Then, select from the categories Edit the Header option.

Show Static Pattern
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When activates Allow dynamic Header option,
the header are added in all page in each report

e set.
W Allow Dinamic Header Then,

whenever you modify the header
template, those changes are automatically made
in all report.

On the other hand, if you want to add pictures on the
end of report. Insert the images number per additional

page defined from the pull down menu. After covering all the images of the
current report, it automatically

allows you to add a page with N
number of interactive images

To design a report template, use the toolbar options to insert questions, titles, pictures,
etc.

A Question box only allows inserting answer boxes. To selects a box just click-on it
and its outline should highlight in blue. Move the box to the desired place with the
mouse pressed down then click to form. To select multiple boxes holds down CTRL
key and select them one by one.

You can even stretch or contract it by dragging on the edge of the text box (the mouse
pointer changes to indicate the type of change).

The question box must be a size that allow fit the answers desired, if it contains one or
more boxes should be aware that the text entered in design mode will be displayed
within the area. When you type in a question or answer box, the size is fitted
automatically, if you want to enter another line press Enter.

Reports can be stored by categories, either by specialty, pathology, etc. For example
you can categorize by ENT, Gastro and Surgery. Within each category you can create
different templates.

If you wish to set as default report click the button “Set as default”. Therefore, this
report is loaded whenever you open report to fill out. To edit delete or rename the
categories press the Edit button.

Then detailing the tools to design a template of an interactive report
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TOOLBAR

T Title

Click the text box to enter the title

E Image

Opens Import Image Windows to insert a picture and resize.

Interactive . .
Image Create a Frame to add any image from a visit
. Question . .
r? Click the text box to enter the question
3 Interactive Text | 't links the text displayed with patient or professional data
Answer
A= Text

Enters a text box that can be modified in user mode.

Option button

That allows the user to choose only one of a predefined set of
options

Check Box

That permits the user to make multiple selections

Drop down list

Allowing the user choose from a list of existing options

Option button +
text

® =@

Idem Option button plus a text box to remarks

Check Box +
text

Idem Check box plus a text box to remarks

Drop down list

Idem Drop down list plus a text box to remarks

i

+ text
1 Separator It is a Line stretchable. Visually helps to separate multiple
— questions or areas within the leaf
f; Font Modifies the font selected blocks and set the font for future
— blocks
Background .
Image Insert an Image fixed
B Background
. Color Set a Background color
| e~ Remove .
x Delete the selected object
Page

Set a paper size and margins

j New

Add a blank page at the end

& Remove

Delete a selected page

INMANUUIN193Rev. 2022.03.28

65



http://en.wikipedia.org/wiki/Set_(computer_science)
https://en.wikipedia.org/wiki/User_(computing)

CROPPING IMAGE

Crop refers to the removal of the image outer parts to improve printing. It allows print
the useful area of the image, saving both printing time and ink or toner cartridges

In Edit=>Cropping menu you must select

The Cropping wizard allows create multiple cropping areas in images to use it then,
and manages crop-area options

e New Cropping area: The User defines a cropping area-circular, to
remove a background portion.

e  Enter a Name to identify a crop area, For example: My fiberscope.

o Next the frame-selection screen will appear; select a picture to be
cropping it the border and then press next.

e To Mark the Cropping Area, clicking on the image edge and then
clicking in the center. The circle indicates which portion of the
graphic you want to keep.

e  Saveortry again

Dark area is a special feature in the optic system layout.

Digital Data Capturing System

If you use "cropping” option to print image, be sure not to miss
detailsof it
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Manage Cropping areas: Activate and Delete a cropping area, choosing it between the
different options created.

Digital Data Capluring System

1010

The Cropping area selected will be applied, when you print images with
the cropping option checked.

TOOLBAR

@ Apply: activates a Cropping area as default to print (Red font)

@ Delete: erase the selected Cropping Area on the list.
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ENDODIGI WEB PUBLICATION

ENDODIGIWERB gives you the ability to upload and share your own cases or reports.
The wizard you assist to publish image videos or reports. Use Next, Back or Cancel
button

A To use ENDODIGIWEeb service you will need to be connected to the net,
Internet

Welcome to EndodigiWWeb

Endodigiweb gives you the ability to upload and share their own cases
or reports. You decide, whether they will be submit in public or private
mode.

To publish, you will need to register first (create a user
account). Do you wish create your own user name and
password?

If you already have a user created EndodigiWeb, click
here to recover it.

First you need register Complete all the required fields to create an account.
You must agree to the terms of use before you can publish on the ENDODIGI

website
Web The web site for you Endodigi Publications

Sign up now and start making your Publications.

Enter your information

Username Password

Name

Last Name

Email

Email Confirmation

I accept the Terms and Conditions of License: View License

e
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If you do not agree to and accept these Terms & Conditions, you do not have
permission to access of this site and therefore you may not use the web Service.

Select
New: to create a publication to attach images and/ or videos
Search: looking for old publications to attach new files or send additional invitations

2

Web The web site for you Endodigi Publications

Select the option. 1o attach your exported files | 0 i Ny (tyna

Il
©

le °

New: Here you must select your audience.
Public: anyone who visits EndodigiWeb.
Private: only people that you invite by email

2

Web The web site for you Endodigi Publications

Publication Privacity Options [ My ;wme My st (e

9 99

In both cases PUBLIC or PRIVATE, you must provide a title and a brief summary
(optional)
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?

The web site for you Endodigi Publications

e
:

A Make sure not to publish patient’s personal and confidential information

Attach in your publications videos, images and reports, previously realized by To
ENDODIGIWeb Short cut

?

Web The web site for you Endodigi Publications

nametest lastnametest (fe.

Video
Videa 11/4/2011 10:14 AM

Video Quality: ] opTiMaL
Attachments sent earlier: 10

99

Add: Attach a selected file, i.e. video Nose

Delete: Erase a file selected

Edit: Open

Video quality: Select the video quality (Optimal or Standard) A higher quality will
increase the resulting file size

Then, tell someone you know about this publication. Adding contacts from your
address book
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ENDODIGI CONTACTS

New Import

There were no Contacts on the Server.

[] Select / deselect all Edit Current Contact (4]

(%)

New: Add a new contact email
Import: This enables you to import your address book from mail clients to
ENDODIGI.

?

The web site for you Endodigi Publications

My name My lastname (Myna

There aren't Invitations to Current Publication

Emal Invitation Message
Me has Invited you to see a EndodigiWeb Publication titled: "XXXX"

9 99
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Now your publication is ready to upload on the website!

?
Web The web site for you Endodigi Publications

Do you Confirm to send the Publication to EndodigiWeb with ‘ urret

following data My name My lastname (Myna

Title

Images: 1
Videos: 0

Attachments Reports: 0
Other Files: 0

Privacity Iane Access - The Publication can be accessed only through an invitation by email
Invitations I— — <ecleris@ecleris.com>

Qo

L Back

Q

Cancel

Q

_Sond |

If your publication was uploaded successfully, you'll see an “Upload succeeded "
message.

é Please note if you attaching many files large, it may result in a long upload
times

Visit the Endodigi website at http://www.endodigi.com to view your
publication

PERFORMING PATHOLOGIES STATISTICS
(It is not available in ENDODIGI Server)

The program provides a simple statistics about the patient pathologies.

To use this tool, follow these steps:
1-  Create your pathologies list. (Options > Data Base: Pathology)
2-  Attach pathologyl/ies in the patient’s visit file. If it is not listed, go to step
1

3-  Perform statistics. (File - Statistical) (See: Statistics Pathologies).

CREATE PAThOLOGIES LIST

This work should be undertaken in order to generate a database of professional
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business, which was then used to attach with the patient data.
Thus, the amount of patients and pathologies constitute a data collection for analysis.

From the main menu: Options—> Data Base: Pathology, you get access to the
Pathologies window.

The pathologies can be added from a predetermined list, select the category (ENT;
Gynecology or Digestive) and then pressing the add list button. You can also
manually add other pathologies completing the pathology field and press the Add
button. The new pathology is added in alphabetical order.

Pathologies

Pathology

TOOLBAR

% Add: Enter description in Pathology text box, and press the Add button adds
- the pathology to the list.

¢ Delete: Erase the selected pathology from the list.

Clear all: Erase all pathologies listed

Sort: Sort quickly and easily the text in alphabetical order ascending or
@ descending.

:I OK: exits and saves changes.
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ATTACHPATHOLOGY IN THE VISIT

On the Visit view, press the button in Pathology to access the pathologies

list (database).
Pathologies
Chronic laryngitis Chronic laryngitis
&= Laryngitis Laryngitis

Cancel éé
nced Edition of the general list of pathologies

To attach pathologies, select one from Pathologies List, then press Add button. To
deletes a pathology into the patient pathologies list, choose it, and then press Delete
button.

Advanced edition of the general list of pathologies: see above CREATE
PATHOLOGIES LIST.

Add: Adding the selected pathology to patient pathology.

oo
'x‘ Delete: remove the selected pathology from current patient.
TOOLBAR

(Wl Save: Saves the listed pathologies and exits.

-

Cancel: Cancel the entire pathologies listing and exits.

3
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STATISTICS PATHOLOGIES

From main menu File-> Statistical you will be able to generate statistics according to
the selected Pathologies.

To perform the statistics, you must select the Pathologies from the Pathologies list and
click the arrow to send it to the Selected Pathologies list. You can select the search
criteria by choosing between “At least one” or “All”. If you select At least one,
patients who have at least one of the pathologies of the Selected Pathologies list were
counted in the statistics as pathological. If you select “All” only patients having all the
pathologies of the Selected Pathologies list were counted in the statistics as
pathological. Having defined the desired options press the Search button. In the list
above you can see the names of patients and the date of studies.

1)

Back: returns to the main
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DATA BASE: PROFESSIONAL

From main window menu, Options->»Data Base: Professionals. You get access the
address book, is a database used for storing entries called professional contacts
(colleagues). Each contact entry usually consists of a few standard fields (first name,
last name, address, phone number, e-mail address, fax number). It is allow add, remove
and edit contacts

| Digital Data Capturing System
T

U . — - ™ [
— - P ]

iC «Clic/1O

e L IR T R

TOOLBAR

@ Show: view contact information from the address book.
o

New: allows you to add a new contact to your Contact List.

Edit: update the contact information and click save.

<N

™\
)

Delete: remove the selected contact from the list
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IMAGE LIBRARY

Create your own Image gallery, with your favorite pictures. You can sort them in order
to use them in future reports or publications.

Create the tree structure using the New, Rename and Remove commands available.
Type a folder name on the text box and the press NEW button. Click on the folder to
select it, before to remove or rename it.

To add Pictures, press Add button and search your favorite picture to insert in the image
library.

mi garganta
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SCREEN SETUP

Select the Size option from the panel in order to specify the dimensions of ENDODIGI
screen:

Screen Settings

@ ' Preset Size
I MNormal

OK

@ Full Screen
) Custom

Width Height

@ 1024 = 720

Maintain Aspect Ratio

e  Preset Size : Legacy - Small- Medium -Large
e  Full screen

e  Custom: Width x Height. Click the arrow button and choose the custom
dimensions(1024X720 is the minimum resolution)

e Maintain aspect ratio: (Available to Full Screen and Custom). Set the
relation between Width-Height of screen.
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DIGITAL SETUP

The digital configuration allows selecting the functioning mode of the equipment. To
access the Digital Configuration Menu, press Options-=>Digital Setup on the main
window of the program.

The Setup dialogue box will appear. The configuration options are the following

GENERAL TAB

;;

Genersl Input  Modules Sousd  Footswitch

0] Ensble automati wwdates Vigeo Praver O MFoundation (®) DShow

TN TR
[ Export Link Ensbled
smeinph
o 12 vl e s
ik 2 it e
[ Custom record start sound
[SP S —

0] Use extermal edtor 2 Bor Controk: tep by Step fiker loading

Ol e

EE s
Eriepel

e

Drivers — Installations: Reinstall: Reinstall or update drivers

It is for advanced users or if the automatic drivers’ installation has failed.

A Before proceeding, please contact the technical support, otherwise it can
cause a malfunction in the system.

Enable Automatic update: Allows the Windows System drivers automatic updates. If

you have automatic updates disabled (unchecked) you can download the update

manually.

Checks Updates: Checks and allow you to download software updates.

-Report:

e  Password protecting: allows you to protect the reports edition module. Thus,
access to modify the templates is restricted to authorized personnel. If a
password has been issued, you will be asked for this password every time you
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- Image:

- Video:

>
>

want to create or modify a report template, but anyone could use templates
without restriction

Export link enabled: Custom option.

Save in Path: stores the default reports in the path indicated

Link:

Use External Editor: If you need to perform more advanced image
operations, you can set an external image editor to be called for ENDODIGI.

Reset link external editor: Click to reset a new external image editor

Preview and Playback Settings: Changes settings the screen mode to
advanced and standard playback, and the capture screen. (See Section:
Configuration of Visualization)

Video player: Mfoundation Dshow, improve synchronization of audio and
video on the player

Double Buffer: Enable Double Buffer in the Capture screen.
3D content switch to 3D: when the content is 3D, it will be visualized in 3D

- Miscellaneous:

>

>

Set password administrator: Establishes a key as administrator to give
users permissions.( See: User Management)

Disable Aero Glass: Disabled Aero Glass, it is available in some Operative
Systems.

Pause transfer to enter the video player: Stops transfers, not to affect the
time-to player. (available in ENDODIGI Client version)

Custom record start sound: Allow select a sound to play when recoding
starts.

Custom record stop sound: Allow select a sound to play when recoding
stops.

Required Data: Allow check the obligatory fields to enter a patient.
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Reinstall: Reinstall or update drivers

ENDODigi SD - Composite - Driver Video Player - DZ

H
]

USB FootSwitch Driver Install Pdf Driver

VC redist

Install HD 3.0

Clear Flag Messages

Enable HL7

SystemUpdates Legacy Drivers WARNING advanced users

Windows Media Video Device Driver

Windows Media Encoder Direct Show Filters

»  System Updates: Updates some system drivers.
e  Window Media
e  Window Media encoder

» Drivers: Device drivers are a computer programs that allow the operating
system to communicate with a device. They are therefore an essential part
without which would not operate hardware.

» USB Footswitch Driver: Reinstall the new driver footswitch. Reads “FS
compatibility Driver” to know if you have a new o earlier version

footswitch.
» ENDODIGI-SD —Driver: Install the software controller to Endodigi SD
versions.
» Direct Show Filters: Allow install Filter to capture and playback video.
LAV Filter
» Misc:
e Video Player — DZ: Sets the factor of compatibility the Video
Player.

e VC Redist: Install C++ components

e  Clear flag messages:Allow see again the warning messages
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about 3D.

Enable HL7: Contact remote support to enable this option.

Install PDF Driver: Install the driver to enable export to PDF
format.

SOUND TAB

To capture sound joind with video, you must check <Capture Sound> and configure
the device from the audio will be taken.

Dt Sohp.

INPUT TAB

All new video capture hardware must be configured from the Input tab before it can

be used. See the section of this manual INSTALLATION: CONFIGURATION AND
ACTIVATION

FOOTSWITCH TAB

See the section, INSTALLATION: ACCESSORIES.
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SECURITY OPTIONS

From the Option menu: Security option Access to User management

Here you can manage multiple users Endodigi to work, store, review files with different
levels of security and privacy.

Digital Data Capturing System

User management

Users:

Users

First Name Last Name username ‘Windows User

{ W)

©

(&)

Pemis

Back.

<]

New: allow signing up a new user filling out a user data.

INMANUUIN193Rev. 2022.03.28

83



User Data

Usermame

Password

Password Confirm

First Mame Last Mame

Email

[7] Automatic Login

Associate with a EndodigiWeb user

Associate with the Windows user.

In the User Data tab you must complete the data required to create an user account
(username and password), personal data (name, surname, email, phone) are optional.

Automatic Login: When this box is checked, the user's password will not be verified to
log into the system.
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Associate with a Windows user:

Windows Users Association

@ Not associate with the Windows user.
_) Associate with the Windows user.
_) Associate with the Windows user. (no password required)

(") Associate with the Windows user. (no password required - automatic login)

karina-PC\karina

e Not associate with the Windows user: Endodigi user is not linked to
Windows user. When you log in Endodigi you must enter the username and
password User Endodigi.

e Associate with Windows User. When the Windows user associated be logged
(eg User-PC \ User), screen log-in Endodigi start with the user Endodigi to
which it is linked and you only need to enter the user's password of Endodigi
for enter the system.

e Associate with Windows User (no password required): When the associated
Windows user be logged (eg PC-User \ User), the log-in screen of Endodigi
start with the user Endodigi to which it is linked. No password required, press
OK to enter.

e Associate with Windows User (no password required — automatic login):
When the associated Windows user be logged (eg PC-User \ User), the log-in
screen will not be submitted to enter the Endodigi, it will start automatically
with the user corresponding Endodigi.

Associate with a ENDODIGIWeb user:

Sets the ENDODIGIWeb user that will be used when the associated Endodigi user is
logged..

If you want you can associate the user with a web user Endodigi (see creating a web
user Endodigi).

It does not create a web account with the same data, but it does linking the two
accounts.

Edit
It allows you to modify user data.

Permissions
Each user can be assigned a specific permission to a resource.
A resource is a data type of software for example "Patients created by Userl".
Permission sets the type of access to the resource, the permit may be:
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e Deny: You cannot access the resource.
e Read Only: Allows the user to view resources.
e Read / Write: Allows the user to view, add, modify or delete resources.

For example: the permissions assigned to Userl shown in the following image.

Security Options

Users - Permits
Resource Name Permit
Patient created by UNKNOWN Read/Write
Patient created by Userl Read/Write New
Patient created by User2 Readonly
Patient created by User3 Deny
Edit

@ Number of Records: 4 - Page: 1/ 1
Close

Userl can modify the patients that have been created by the user Unknown and the
created by himself. (Patient created by Unknown - Read / Write, Patient created by
Userl - Read / Write).

User1 has only read access to patients created by User2 (Patient created by User2 -

Read Only). These patients may not be modified by Userl but you can see them in the

database screen and can open them for reading.

Userl does not have access to users created by User3 (Patient created by User3 - Deny).

These patients may not be modified by Userl and cannot see them in the database
screen.

New: Assign new user permission.
Edit: You can modify permissions on the resource.
Delete: Delete permission from the list.

Groups
Users can be organized into groups and permissions can be assigned to the group
instead of the user individually.
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Security Options

Groups

Name Description

RESTORE

©

1
#

()

Permits

@ Number of Records: 1 -Page: 1/ 1
Close

New

Allows create a group of users by using the Add and Remove buttons.

When adding a user to a group, the group obtains default permissions Read / Write for
patients created by the user. That is, if the User3 is added to Grupo23, all group
members can modify patient data that are created by User3. Laterit explains how to
change these permissions.

Group Data

Name
fcrou 23

Description
IUser 2and 3

Group Members

First Name Last Name Username
User3
User2
Add

Create Group
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Edit: You can edit the fields of the Group Data tab.
Delete: Delete a group.

Permissions: Set security options of the group, adding, editing or deleting permissions
from the list.

In the image below we see that the members belonging to the selected group will have
access to Read / Write on patients created by User2 and User 3.

Groups - Permits

Resource Name Permit
Patient created by User3 Read/Write
New

Patient created by User2 Read/Write

@ Number of Records: 2 - Page: 1/1 a
Back
Close

Permission priorities

Each user can have individually permissions and user group permissions. User
permissions take precedence over Group permissions.

If a user belongs to more than one group, it is the most restrictive access which takes
precedence.

For example for the following system configuration:

User Name | User Permission

Userl Patient created by Userl - Read/Write
User2 Patient created by User2 - Read/Write
User3 Patient created by User3 - Read/Write
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Group Name | Members | Group Permission

Group A User3 Patient created by Userl - Read/Write
Patient created by User2 - Read/Write

Group B User3 Patient created by User2 - Read

Patient created by User3 - Read

The User3 has the right to:

e Read/ Write on patients created by Userl because it belongs to GroupA.
e Reading on patients created by User2 because it belongs to Group B.

Although also belongs to Group A that has permissions on these patients, the

priority is the most restrictive access. If you want the User 3 has write

permissions on patients created by User2 without removing Group B then you

should add as permit user because user permissions take precedence over

group permissions.

e  Read / Write on patients created by User3, because user permissions take

precedence over group permissions.

Security options

OPTIONS

Languages

Data Base: Pathology
Data Base: Professional
Image Library

Screen Setup

Digital Setup

ENDODIGI WEB

User: UNKNO

User Management
Activity tracking
Clear list of Recent Users

Associate with the Windows user.

L3
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Clear list of recent users: The first time a user log in, can decide if he wants his name
to appear on the user list that appears in the login screen.

Unknown User: If this option is enabled when a user log out, automatically log in the
Unknown user.

Associating with the Windows user: NET / WMI / Disable. Select the technology
used to poll users Windows. Consult technical support

OPTIONS ENDODIGI WEB

User Data: Allows access to user data.
Log out: Logs off the current user.
Change User: log off the current user and displays the login screen to change user.
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DISPLAY SETUP

Changes settings the screen mode to advanced and standard playback, and the capture
screen

View Settings

@ @ Preset Size I Small

Ok | Full Screen

|v| Maintain Aspect Ratio

/| Snapshot Preview

Snapshot Preview for: I 3 > sec.

V| Thumbnails
@ Make persistent changes

Adjust the display setting:

Preset Size: Small- Medium —Large
Full Screen
Maintain Aspect Ratio

Note: Please understand that there are differences between “screen resizing”

A and the above option. This option attempts to stretch the movie to comply
with the dimensions specified, while also maintaining the video clip aspect
ratio.

Snapshot Preview: This sets whether or not to display the captured snapshot on the
screen immediately after the image is captured. It allows delete or confirm the snapshot
before the timeout is reached. This timeout (second) is programmable.

Thumbnails: It deploys the thumbnail viewer.

Make persistent changes: The selected screen size is always on, both in the recording
and playback of movies
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TECHNICAL SUPPORT

To request technical assistance, click on Help=>Supportmenu.
Access the following screen.

Technical Support

Select Type of Technical Support
RequestRemote Assistance. Enables to

J Remote support B | e S e
problem through remote access
Contact Data
Country City
Distributor
Name and Sumame
Phone
-l | [ |
Format +{Countyy Code] [Area Code] {Phone Number]
Email
Serial Number

Defining the Problem

KIND OF TECHNICAL SUPPORT

-Email Support: the field required must be completed and is send the query. The
technical support will receive an email with that data, after that it will answer through
the configured email address.

-Remote Support: This mode allow that technical support establish a remote
connection to try solving the problem.

It’s possible that technical support is not available at the moment of realize
the query. If so, you be informed how time the service will be available, to
decide wait or realize the query when the service is available. See Technical
support is not available.

THE SUPPORT ENGINEERS CAN COMMUNICATE IN ENGLISH AND
SPANISH. HOWEVER, SUPPORT ISSUES WILL ALWAYS BE ANSWERED IN
ENGLISH, UNLESS WE KNOW FOR CERTAIN THAT YOU’RE PRIMARY
LANGUAGE IN SPANISH, IN WHICH CASE, WE WILL USE SPANISH.
SUPPORT TEAM DOES NOT ANSWER E-MAILS IN ANY OTHER LANGUAGE.
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WAITING AREMOTE CONNECTION

After that technical support receive the application to Remote Access and until in fact
is established or canceled the connection you will see the following screen.

Technical Support

ﬂdddddddddddddddddddddde

Waiting for 1 tion from Techm:
Support of Ecleris.

Cancel

A If you cancel process, technical support will not able to establish the remote
connection.
TECHNICAL SUPPORT NOT AVAILABLE

When the technical support request is not available to attend a remote connection, is
shown the following message.

Technical Support

& Remote Support - Message
Message from Server:

Date and Time: 26/11/2013 11:08:53 p.m.
Message:

Technical Support is available in 9 hour/s.

It is seen that Technical support will establish the connection within 9 hours. You can
close the message and wait until establish the connection or cancel the technical
support application and try later.
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BACKUP AND RESTORE DATABASE

The backup and restore provides an essential safeguard to help protect your data stored
in database. The topics in this section explain how to use to backup and restore the
database, transaction logs, and file and file group backups.

@ Have any doubts consult the technical service

the software configuration (often is in C\ Program Files\ENDODIGI) just

@ If you wish to make a backup of the ENDODIGI folder, all its contents and
copy it to a safe place or external hard drive.

@ In Client version can only make backup of private files.

MAKING A BACKUP

You can make a backup with a simple touch on Backup button on the database. It helps
you to protect your patient records (videos, picture, sound, reports) from accidental
damage or to reduce the number files on your hard disk, freeing up space. They could
be restored later if it is necessary.

Select the backup mode.

Digital Data Capturing System
[ s —————— ]

Mode Salect an operating mode to backup

(Standsrd. Uimited optons)

Date Range
(Advanced)

Custom
(advanced)

%)

e

i

» AlLlIt is most easy to done. Simply select a folder or drive and the entire
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patient Files will be backed up.

» Date range: Limit your backup of files to a specific date range by selecting a
complete month, day and year combination

»  Custom: Select the items you want to include in the back up one by one.

And follow the backup wizard instructions, using the Next, Back and Cancel buttons

Digital Data Capturing System

List Select the visits that wil included in backup

Date Frsthame  Lastheme D Chate  DaaVist  NemeVist  DsteBackup LsbelBackup  Pe
18/07/2013 .. test o = = 19/07/2013 ... Banco 1 19/07/2013 .. Bockup 19/07... C:
18/07/2013 .. test o = = 19/07/2013 ... Banco 2 19/07/2013 .. Backup 19/07... €:
18/07/2013 ... TEST o = = 19/0772013 .. 18/07/2013 .. Bockup 19/07... C:

Qoo

To carry out a backup copy of the patient files and visits (banks). You will need to
select a folder or an external storage device (SD, or USB Disc). (e.g. “C:\New Folder”).

Digital Data Capturing System

Destination ‘Select a valid destination

Disk Backup Label Remaining Space
Weackur 190772013 12:30:33 Bi36.8¢5.00 v
. wired Space
Destination
= r— v ) |124 57 MB 0,09 %

Gurent Free spzce
Jisorai7ve e

So then determines the unit Information
The disk size available (free + used)
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The amount of disk space that a copy consuming. (Required space)
The disk size free (free)

Type a disk Label (optional) and Next, shows a Backup summary before to Start to
copy.

The Backup progress will be indicated by a progress bar (%).This may take several
minutes. When the backup is completed, a confirmation message appears.

Digital Data Capturing System

Summary Press Start to beginning backup

Label Backup: Backup 19/07/2013 12:30:33
Destination: C:\Users\usuario\Desktop\
Number of selected Items: 3

Patient: test 01 -- Visit: Banca 1

Patient: test 01 - Visit: Banco 2

Patient: TEST 02

Freeing space from the database

L e

9

A If the box “Free up space” is checked, the Files selected will be copied and
removed, however if it is unchecked the files will be copied only.

Note that the visit folders whose data were eliminated remain "Locked".

@ All copies made from this form will be recorded in the database Backup.
Thus in the future, if necessary, you might restore them.

A By default, throughout the backup process, the error log file is created. It
contains all the errors detected since the backup was started.
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MAKING A RESTORE

Restore a database is very simple, it is only consider the location of the backup.
Pressing Restore button in the database screen the wizard will start.Here you can

select:

Digital Date Capturing System

Source Setect 4 Gata source

Path Backup
I -

%)
©

Path Backup: Enter the path to the directory where the backup is located. (e.g. “C:\
New Folder™).

Backup Database: Every successful backup operation is saved to a list. It is a sort of
summary of everything backups. On the list you can search copies by their descriptions
and the access path to restore them.

Digital Data Capluring System

©
©

Delete: Erase a selected backup item to list
Change path: Modifies the suggested backup location.
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And follow the backup wizard instructions, using the Next, Back and Cancel buttons
Once you select the items to restore and press Next button, restore summary appears

Digital Data Capturing System

The restoration Options must be established by:

Access Option (Only available in ENDODIGI Server version)
e  Keep Access: maintains the previous access
e  Private: The patients will be restored as Private
e  Server: The patients will be restored to the database server (This requires
client-server connections)

In the case a bank is not empty you may:

Overwrite: The restored the data replaces the existing file.

o Not Overwrite: A new bank is created to copy and restore the data, keeping
the existing banks intact. In these cases you may bank duplicates

e  Skip: the Item restoration is canceled and skips to the next step.

Digital Date Capturing System
™

Resume owe 1320 10 bungmr rotare

I of salactd Hame |

Patmnt: po pre - Vs Bance 1

The Start button begins the restore process.
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INSTALLATION

COMPONENTS

The ENDODIGI Digital Data Capturing System includes the following parts

necessary for its installation and functioning.

Main unit mt
Microphone \7
Footswitch @

USB Cable @

User’s Manual

CD Installation (2)

Optional:

Wireless footswitch
(battery AA required-Not
included)

ECLERIS®,

(1on)

%

Note: The actual product may vary from the illustration Ecleris reserves the
right to change the delivered components of the equipment according to
availability.
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REQUIREMENTS

Windows 10

INSTALATION

Updated Windows 10

Intel 15 2.5 Ghz

16 GB RAM

Dedicated Video board with compatible with Intel Quick
Sync

Screen Resolution: 1024x720 24 o 32 bits

USB 3.0 port (with drivers correctly installed)
Windows Media Encoder

Microsoft .NET Framework 3.5

Network Interface Card 1GB (For Endodigi client)
Disk space: 500 GB of free disk space

To allow to use the device it necessary complete all steps

INSTALATION: SOFTWARE
INSTALATION: VIDEO CAPTURE DEVICE

INSTALATION: DRIVERS

INSTALATION: CONFIGURATION AND ACTIVATION
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INSTALLATION: SOFTWARE
Follow the advice below for safe and appropriate installation:

@ It is recommended that installation will perform by a skilled technician.

Before starting the installation of ENDODIGI, close all applications that
are running on the computer you are going to install the device.

Please verify that your PC meets the system requirements to install
ENDODIGI.

installing the software.

You make sure ENDODIGI is disconnected from the PC before proceed
A Insert the disc into the computer and follow the onscreen instructions.

CD automatically attempts to start the installation wizard. In this case, appears auto
play dialog box, where you can run the wizard. If the installation program does not
start, going to start- 2run and selectCD: \Setup.exe

Select the installation language and press Next to start installation process.

It is recommended to follow the options that appear by default, by pressing Next button
in each of the screens, unless indicated otherwise.
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4 WARNING: The ENDODigiNV and the USB footswitch should be
/B DISCONNECTED uniilinstallstion program request you that connects
them to the USB port

The installation program will automatically begin the installation of the drivers.

Press Install to continue

;Desea instalar este software de dispositivo?

! Nombre: Microchip Technology, Inc. Puertos (COM ..
«r Editor Microchip Technology Inc.

] Siempre confiar en el software de "Microchip (| msssr [P Noinstaiar_]
Technology Inc.". —

! @ Sélo deberia instalar software de controlador de proveedores en los que confie. ;Cémo puedo
é ra instalar?

idir " ispositiv "
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Ecleris USB Driver install

‘ Installing Ecleris USE Drivers... Please " ait

A DO NOT Restart the PC until installation is finished completely.
A Put the windows taskbar into auto-hide mode.

If you experience problems during installation please do not hesitate to contact
the technical Service
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INSTALLATION: VIDEO CAPTURE DEVICE

Wait until Windows has booted completely, then connect the device.
Connect the video source (Endoscope, Video Camera, etc.) into the video
connector.

Connect the USB cable to a free USB 2.0 port on your computer.

Connect the Footswitch to USB port.

Note that the ENDODigi HD exclusively uses a USB3.0 port, whereas the
A ENDODigi SD can be connected to both a USB2.0 port and a USB 3.0
port.

Do not use the front ports of desktop PCs since normally they are not
correctly assembled. This can cause communication errors.

ENDODiIgi

[ mwm]]
| ENDODigi HD -> USB 3.0

ENDODigi SD -> USB 2.0

My

WFS

MIC / LINE

USBFS

Conexions
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INSTALLATION: DRIVERS

The PC recognizes a new hardware device and automatically installs the corresponding
driver:

Video Driver:

é You must logon with administrator privileges to install the device

Once Windows is fully booted up, it will display a message bubble in the taskbar to
indicate "Found New Hardware". The required system drivers will be automatically

installed.
Wait until Windows displays another message bubble indicating that the new hardware

was installed successfully.

A Driver installation may vary depending on the operating system.

INSTALLATION: CONFIGURATION AND ACTIVATION

In order to use the ENDODigi, at least one video input must be configured. To do
this, go to the main screen menu Options ->Digital Configuration - Input Tab

IMPORTANT: the device you want to add must be connected to a USB 3.0
(HD version) or USB2.0/ 3.0 (SD version) port.

Selecting the tab will automatically start the search for ENDODigi devices
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Showing the devices that can be added-configured in a red background and those
configured in a green background. Each device will be displayed as
Connected; Not configured; Disabled.

Press button +Add

ENDODigi SD - Composite

[0 Composite N PCLERIS V:100, R:100 ‘+‘ ’
D( — o Add

weur

SN:30000001

You will be asked if you want to add the device, press the Yes button

The new device will be added showing version and serial number. Changing its status
to Connected; Configured; Disable on green background.

ENDODIgi SD - Composite

P — -
- |ECLERIS®.
[ © [composie & uUN < V:100, R:100
Add Camera D']‘W"w el

SN:30000001
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A default camera name will be created
associated with the device. It is
important if you have more than one
camera to change it, pressing on it and
entering a descriptive name. Add Camera

(O [Composte | 8 U@

It is possible to configure up to 3 cameras with different names and video settings in the
same input. Use the Add Camera button. Multiple cameras in one input means that to
change cameras you must disconnect the current one, connect the one you want to
select and then choose the camera, based on the name, on the capture screen.

If you want to connect up to 3 cameras to separate inputs (you will not have to
disconnect and connect when you want to change cameras) request an Ecleris video
input selector from your Ecleris dealer or ask for more information at
support@endodigi.com

Finally you must activate the device by pressing the Activation button

V:100, R:100
USB 2.0 —))-
OUTPUT ]}m o1

000001

Fill in the form with your email and press Start in the Activation dialog

1

Device
] £100019i 5D~ Composie; SN 30000001

5 T
O Usi pport (Only for cases of automatic

@ Select an option and press the Start button

Cancel
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A IMPORTANT: Press the Save button to finish
the setup.

Cancel

CONFIGURE CAPTURE DEVICE

Will be show a windows with the options to configure the video input

T o

Render  Jf] OEFAULT - Second choice on w7~

[] Fix interlaced Image

Name: l HDMI |

ENDODigi HD ~ HDMI:HOMI

Timeout [s.] - EEE
e

Render: Select the active video render.
e  Default: Second option for W7.
e  VMRY: Preferred option for W7 and W8.
e VMRO9: Second option for W7.
e EVR:Render of Compatibility.

DEVICE SD

Fix Interlaced Image: Reduce the video resolution on captured image. Remove the
interlaced and allow the use of device on old computer or with codec issue.
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DEVICE HD

Setup Wizard: Starts the wizard to optimize the HD hardware configuration. The
assistant performs a functional test and use questions to select the recommended
hardware configuration.

up Wizard - HD USB 3.0

Welcome to the Endodigi HD USB 3.0 setup wizard. We will evaluate the performance of your PC to operate with
Endodigi HD USB 3.0 and the needs of the application for which it will be used. For this you will need to connect the
Endodigi HD USB 3.0 to the pc, to a usb 3.0 port if you have and have connected the camera to use. At the end, we
will select the recommended configuration parameters that best suit your needs and the environment where the
Endodigi software is installed.

To continue press Next.

Cancel ‘ Next

|
Advanced Configuration: This option is only for advanced users. Before proceeding,
consult your technical service, otherwise it could cause your system to malfunction.

Image - TimeOut: Advanced users. Allow to set the timeout to wait the image
file.

HD 3.0 Configuration

Connection Frame Rate (Preview)
I 1920 x 1080 " IEO
ok : - : -

Frame Rate (Encoding)

60

Cancel
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INSTALLATION OF ACCESSORIES: CONFIGURATION AND ACTIVATION
WIRELESS FOOTSWITCH

Connect the USB reciver, directly on available USB port of computer. disponible de
su computadora.

ECLERIS¥>

(o)

Install the baterie 9V format 6F22 on the internal box of footswitch. To inser the
baterie only pick up the cover from hole located on left side of box. See the images
like example.

INSTALLATION OF ACCESSORIES: CONFIGURATION AND ACTIVATION
WIRED USB FOOTSWITCH

Connected the USB cord directly on USB of computer, the drivers will be
automatically loaded.
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Connect the footswitch on USB port computer, when enter of Footswitch Tab, the
software automatically start the search the footswitch connected.

Refresh: Search again the USB footswitch connected on USB port computer.
Add: Enable the footswitch to allow is used.
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Save: Save the changed realized.

Configure: Open a windows that show the option to use footswitch. (see section Use
of Footswitch).

Cancel: Cancel the changes realized.

Delete: Delete the footswitch configurated.

If you have an USB wireless footswitch that is not recognized
automaticaly, you can add on manual way, press the button “Add
Footswitch Legacy”.

footswitch will be added automatically when is added the capture

If your capture device just has included the wired footswitch. The
A device.

INSTALLATION ACCESSORIES: COMPOSITE VIDEO SELECTOR

Connect the accessory on USB port of computer. With this accessory you can change
until 3 video input without disconnect any other camera connected on inputs.
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See the following conection schematic.

USB PORT COMPUTER

ECLERIS*

INSTALLATION ACCESSORIES: HDMI VIDEO SELECTOR

Connect the accessory on USB port of computer. With this accessory you can change
until 3 video input without disconnect any other camera connected on inputs.

e

USB PORT COMPUTER

ECLERIS®,

o
ous outrur
10 tnooom! st

[—
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CLIENT CONFIGURATION — Only Server version

The configuration is necessary to connect to server through a local TCP network.

Client Configuration is found into options of principal menu, Options=>Client
Configuration.

On top-center of screen there are three tabs to choose.

It’s not necessary to be connected to realize changes in Client Configuration.

CONFIGURE A CLIENT
Choose configuration tab.
Click on icon Edit to realize changes in parameters.

Client Name: User or client name to ENDODIGI.
Server IP: Name or IP Address of equipment that act as server
Server TCP Port: TCP Port address of equipment that act as server

Complete the parameter configuration with valid values, if you have troubles
then consult the ENDODIGI SERVER administrator.

Save your current configuration and accept the reconnection message, after that
automatically the connection will start.

Test the connection. Press the icon Test, if the connection was successful then you will
see a “Test OK” message.

Client Data

©

Save

client ame  [Jcrient1

o
i

sever e 127001

server Tcp port 10000

Connection

Asynchronous [| 2 enable

— Timeout [sec.) ] 30

Log Events B[J £nable
Communical tion

Back
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CONFIGURATION

Parameters:

Configuration

‘ . l ‘ : ‘ @
client Name [JCLEENT1 Edit

server 10 [J127001
server TCp port [J10000

connection [Jasynchronous Disabled

Last
Session <

GUID Ic23d4dd4—1d7aMﬂald—ﬁd4bdh7hh6c9
Version [J6000

1P Address [J192.168.56.1

6 PC Name I User-PC @
pCusers [ User
Back Test

Client Name: User or client name to ENDODIGI.

Server IP: Name or IP Address of equipment that act as server
Server TCP Port: TCP Port address of equipment that act as server
Connection: Type of connection enabled.

Last Session: Show the n times that it was connect successful to server.

GUID: Unique identification to client.
Version: Client Version number.

IP Address: IP Address of local PC.
PC Name: Name of local PC.

PC User: User name of local PC.

[: Test: Allows testing the connection to ENDODIGI server

| Edit: Allows edit parameters
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CONNECTING TO ENDODIGI SERVER

Once the client is configured is ready for use. The client-server connection is
established automatically whenever Endodigi starts in the client PC, except that the
server is not available or there is a problem in the local network. A message that cannot
connect appears in which case.

Data transfer Client<>Server, is automatically set (provided there is client-
@ server connection)

The rate of every transfer depends of local network bandwidth and the
ENDODIGI server configuration.

PROGRESS BAR: During the file transfer a progress bar appears which indicates the
process name and the execution percent.

Waiting to connect to Server

PENDING OPERATIONS: The software determines the priority operations and
automatically pause the data transfer from the client to the server, thus optimizing
resources. Similarly pending data transfer automatically resumes upon release resource.

Waiting to connect to Server

M Shutdown the PC atend of Operations.

Shutdown the PC at end of Operations: Turn off the pc after finishing the pending
operations
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APENDIX FIREWAL

L CONFIGURATION

(Only it is available in ENDODIGI

Server)

By default ENDODIGI client search the server into Local host. Before change the
firewall configuration, you must configure the ENDODIGI client.

There are four typical firewall setti

ngs, if your firewall is not on the list, configure it as

indicated in the manual for your firewall.

WINDOWS FIREWALL

Go to Start->Control Panel->Sys

tem and Security=>Windows Firewall press Allow

programs to communicate through Windows Firewall.

Q)= + comripome » sysemmisecy +

Control Panel Home

* System and Security

— o

Allow programs to communicate through Windows Firewall
To add, change, or remove allowed programs and ports, click Change settings.

What are the risks of allowing a program to communicate?

Allowed programs and features:

Core Networking

[ Distributed Transaction Coordinator
[IFile and Printer Sharing

[ HomeGroup

isCsl Service

[OMedia Center Extenders

[ Netlogon Service

Network Discovery

[ Performance Logs and Alerts
Remote Assistance

[JRemote Event Log Management

Name Home/Work (Private) Public *

[W] Connect to 2 Network Projector =] 5]

‘

5 D00D0O000000N

ED!DK‘DDDDDDE
B

Allow another program...

Click on Change setting, after that click on Allow another program
Select ENDODIGINV .exe from program list or click on Browse.
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Select the program you want to add, or dick Browse to find one that is not
listed, and then dick OK.

Programs:

|4/ ArtRage Studio

O ASUS Vibe Fun Center

2 AsUs WebStorage =
L Create a System Repair Disc

- WENDODIGINY

B Intel® Control Center

@Inhel@ Rapid Storage Technology

?Inhemet Explorer

elnbemet Explorer (64-bit)

B¥kindle For PC

w Microsoft Silverlight -

-

| »

Path: C:\Program Files (x86)\ENDODigiNV\ENDODigi | Browse...

What are the risks of unblocking a program?
You can choose which network location types to add this program to.

Check Home/work (Private) and Public

<« Firewall de Windows » Programas permitidos

Buscar en ¢l Panel de control

Permitir que programas se comuniquen a través de Firewall de Windows
Para agregar, cambiar o quitar programas y haga clic en C.

Cules s0n los riesgos de permitir que un programa se comunique? ) Combiar Ia configuracion
Brogramas y caracteristices permitidos:

Nombre Doméstica/trebajo (privada)  Piblica *
O Administracion remota del volumen

B Asistencia remota

O Captura SNMP

A Compartir archivos e impresoras

O] Conectarse a un proyector de red

[ Coordinador de transacciones distribuidas
[ Deteccion de redes

D Dispesitivos poritiles inalambricos

[ enpopigin

DlEneutamiento y acceso remoto

O Grupo Hogar

=

oo

i

DOoOo@goROoO0o00o®a
DOoogoROoO0o®O

Finally you must accept the changes.
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ZONE ALARM SECURITY

There is an attention message when you try to connect a remote application. Check
“Remember this setting” and press Allow. You must repeat this procedure when you
realize change setting in Client Configuration.

f ] ZoneAlarm Security Alert

= REPEAT PROGRAM
V.11.09.06 is trying to access the Interet.

ZoneAlarm Security Alert
REPEAT PROGRAM
V.11.09.06 is trying to access the Internet.

Identification: Not available in ZoneAlarm Identification: Not available in Zonedlarm

Application: ENDODigiNV.exe Application: ENDODIgiNV. exe

Destination IP:  127.0.0.1:Port 10000 Destination IP:  192.168.0.34:Port 10000

More Information Available: More Information Available:

This program has previously asked for Interet access. This program has previously asked for Intemet access.

SmartDefense Advisor SmartDefense Advisor
? Advice is not yet available for this program. 2 Advice is not yet available for this program.

Choose below or click More Info for Chaose below ar click More Info for
assistance. assistance.

[¥] Remember this setting. Remember this setting.
L [ awow ][ ey ] y [ miow ] [ peny
MANUAL CONFIGURATION

Enter main window of Zone Alarm Security, through task bar or direct access of
program

-Go to Program Control->Programs. If the program not appears in program list then
press Add and select the correct program.ENDODIGINV.exe

bl

ONEALAR‘M' FREE FIREWALL

S €/ You are protected. No action is required.
22, - Zonealsrm is working hard to protect you. See how.
Frowal ;
(03 Frews Firewall Additional Services
[B) Program Cortrl Blocks hacker access 0 your FC
[ Artghenng E— identity Protection
- | More ways to protect your
[N Aorts 8 Logs \dentty
Anti-virus/Anti-spyware
® Secure Oniine Backup
) Unoade for Artona/Ack sovire. @ Protect your documents,
photos and music
Learning Center
gy Anti-phishing #)| Leam about todays latest
v, 0 Blocks dangerous Web stes threats
borade 10 337 Qowriosd Protecten
Browser Lock
v“:1
2. Logade 1o biock browser expiots
Verty you are rurrang af necessary protecton on ths comeuter
© Help

You must press over the signs to allow the access, you choose Allow item in Trusted
and Internet columns.
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[ o =
- s Programs ' ‘SmartDefense Access SEaEy =
& Frewal Trusted  nternet | Trusted Intarnat
P Coiet ™1 Cliert Server Runti...  System - 9 ? 7 ?
™ 1 Consent Ul for acim...| Auto - 2 ? 7 7
Main
- 8 Console Window ... Auto -2 7 ? d
[ Atishishing T Host Process for ... System - d J 4 J
B et ™1 Locsl Securty Auth... System - J J ? @
&logs ) Run Once Wrapper | Auto - 2 ? 2 ?
Clservicesand Cortr.. | System v ] F 3 J ? 3
Tlsmssexe Sytem < "] ? 7
Clsrvsys Auto ~ 2 2 ? 4
| =] userint Logon appi...| System Fl J ? 7
¥ vioeos | Custom i ? Pe |
=] visual C# Command... Auto - y ?
VE VNC Server FreeE...| Ao - & 7]
G4 Windows Explorer | Auto - / . X X 1
B windows Logon4p... Auto v ? 7 i e - N
Entry Detail I
Product name. Endodigi
File name
Last policy updste Not applicable Add
Version 11.09.0006
@ Help Last mocified dete 12102011 12:51:18 -

-To accept the changes you must close the screen configuration.

MCAFEE INTERNET SECURITY

Enter main window of McAfee Internet Security, through task bar or direct access
Go to Navigation Center>Firewall.

& ome
McAfee  internet Security & Nevigation

© Aot

2 wew

J Your computer is secure (no action required)

Navigation Center

Access and manage your features, change your Setlings and account information,
and take advantage of the resources and support opions available to you

Settings Features
Subscion ganvouee

B . o cistom s o earoats s
eneraisetings | o

Features Elresal

Protect against nruders who cen hfack our PC or steal
3ion. nd conros e inormation hatyour
ends ang rece

Reports and
Logs

Secunty Repodt lows Y04 1 248 controlof what yourfamily can see and o
Parental Controls onthe we!
Report

sine Backuy

History and Logs Oniine Backup lets you save your most important files
cnlie 50 a ou can getlo Bam fom amwhers any me

Mcatee Mmusi

Resources QuickCie

Heip and Support Felps mprove your PC' pertormance 85l you scese
unnecessary files, such as old ActiveX

TheeatMap

husader

Virus Information ect yout pevacy by leting you permanenty
Lbrary @ Cinindte H6s at Contain 3ensivee o
HackenVatch @

About
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Click on Internet Connections for Programs. After that you press Add and you choose a
program from program list or search through button Browse.

'@ McAfee | intemet security

\/ Your computer is secure (

Firewall: On

o steal personal

informason, Leam mors

rom making nsky connactons. Leam more
Program Access
3! B3 Sentces and Conroller app i

5' 53 HostProcess for Windows Senices  Full

You must put Access as Full.

W McAfee  intemet security

Firewall: On

Firewall protacts yout PC aganst nbuders who can Njack rour PC o steal personal
formason. and polkes e informaton jour PC sends and recenes |eam more

o flom making isky Connectiens. Lean more

Add New Program

Progam

CProgram Fites (86 1ENDODIGNVENDODIGNY ese
sccess

a3

Nt Guard.

WMcAfee | internet Security

\/ Your computer is secure (no action required)

. — —

Firewall: On

your PC who PCor
information, and polices the information your PC sends and receives. Leam more

(Tumon | | Restore Defauts |

I

Decide which the Ints
from making risky connections, Learn more

1t and use Net Guard to

Program Access Net Guard
¥ ouroan Ful

&3 Senices and Controller app ™

&7 Host Process for Windows Services Pl

>
5
) &7 Host Process for Windows Servces  Full
)
>

&7 Local Securty Authorty Process fun

-Save the configuration and exit the application.
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NORTON INTERNET SECURITY

You must enter to main window of Norton Internet Security through task bar or direct
access.

Norton Internet Security

LiveUpdate » m Advanced »
LastUpsate

Go to Settings—=>Networks—>Smart Firewall, in Program Control press Configure

Program Control

Acoass
L]
L]
Add Modity Remove Rename
V/ Norton oK Cancel Apply.
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Click on Add to search the ENDODIGI Client and then you chose Allow from access

column

Press Apply, after that press OK and finally exit the configuration.

Program Control -

Program Control

you want to do?

Program Control

r a
~ E
B
Add Modity Remove Rename
et oK Cancel Apply
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APENDIX CLIENT HL7

SPECIFYING IDENTIFIERS

Patient

A patient identifier (patient ID) uniquely identifies a patient within the hospital or
Endodigi System. The patient ID is Medical Record Number (MRN).

Visit

The visit is identify with a unique identifier 1d the Patient Account number ID.

Reports
To export in PDF format to EMR the filename format is formed by the following
fields:

Application ID: Required 30 characters. Fill with spaces to the right. 22 custom 8
reserved for control version

Visit Name - FA#: Required 12 characters. Fill spaces to the right if necessary.

Chart - FP#: Optional 10 characters. Fill spaces to the right if necessary.

Form ID: Required 15 characters. Fill spaces to the right if necessary.

Delete Flag: Optional 1 character.

Number of pages: Optional 5 integers. Fill with zeros to the left.

Date of Birth (yyyymmdd): Optional 8 integers. Fill with zeros to the left if necessary.
Sex (M,F,U): Optional 1 character. Space fill if necessary.

The Form ID, Flag delete and Version control are configurable.

If flag delete is activate the previous copy exported to EMR is sending with the flag set
“Y” before to send the new one with the flag set “N”.

If version control is activated a number of eight digits is added to the Application ID
field.
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CLIENT ED WORKFLOW

List Database
ol Client ED
ED. '
| User search in list
Server Patient | database

Ol = = ——
Database o o £ 3 -~
—
L -
=
-

T

Server Patient | User open Patient - Visit
- Database

[ j A
" Lock patientaisit to open

User perform

procedure

Delivers the results ] I
in the colfeed path POF report Default

_ —_—— | Extvst

POF Reports
Images
> Videos Pending server
4 1] Etc operation

The active pdf report is sent to the Server ED automatically when user in client ED
terminal leaving the visit. Next, the server sends the report to the EMR. Once the Server
ED finalizes the sending of the active pdf report to the EMR (coldfeed path), it is
possible to leave the visit. If the delivery process to the EMR is not completed and user
left the visit, the report will not be sent until the next user open/ close this visit.

REPORT EDITING

Once the report is generating, user can edit it in the client terminal. The fields linked to
the demographic data will be completed with the actual database data at the first time
created. Then the user can edit or manual refresh.
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LIST DATABASE - CLIENT SIDE

Digital Data Capturing System

User: UNKNOWN

e — — - Vit Narna
021020171126 HUGO DANEL FPOD000038 FAQ0001258
02/10/2017 945 HUGO DANIEL. FP00000038 FAD0001250 Private Patient
aanazony oers  po are - Frcaantres =
a2 0530 #o are FPocuoo0s0 Froooor122
o0z 05 swH FRATK Fpoosoncao fhressctis
otnoor7sas s Fra Frooacoazo Frconoross
LT
e

Fiter

CLIENT USER - PATIENT SCREEN - EDIT

Server
ED, Client ED
! |

User try access to
patient screen to
edit

access permission response

Patient Screen

L Yes

Server Patient Database Show
personal data

Fields Editable
by Clients

Fields editable by EMR

1-- [
©

User modies only
the editable fislds

by Clients

No

Server Patient
Database

Fields Editable
by Clients
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OFFLINE MODE

When network is unavailable, the client has the possibility of create private patient. On
this mode all fields are available to edit. The user, from client terminal can complete the
demographic data of the private patient and generate a report to send to EMR colfeed
path. To open private patients previously created, user can select database private in

Database screen

CLIENT HL7 SETTINGS

In each hl7 client it is necessary to set the following parameters by entering Digital

Setup -> HL7 Setup.

Devics General | Modules HD 3.0

(] Ensble automatic updotas

(] Export Link Enabled

Save in Path

Run Link

[] Use external editer

Application ID: Name of application.
Path: Colfeed Path to private patients.

Drivers - Installations

Videa Player " MFoundation  * DShow

Ol Double Buffer & 30 contant switch to 30

O Disable Asro :s

[ WMI Hardware

[ Custom record start sound

I Custom recard stop sound

] Pause transfer, to enter the video player

Required Data
£ Last Hame
) Namar
O chart 2

Output: Send automatically when exiting the visit screen.

If you not select the automatically mode, you can sen HL7 reports manually from

Export Visit menu in Visit screen.

o

Save

Application ID IEndnd\g\

Report form 1D IFormRepan

%)

Cancel

HL7? EMR Flag delete (1

Path Ic-\Userstmun\Dsskm;:\Expnn,HU,anan D

Output [ send automatically when exiting the visit screen.
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General information @

Visit 1
26/2/2020

Images

Videos

Images:
Videos:
Reports:

Reports o @

Report 9/3/2020 12:53:17

Report form ID: This custom field is added to the format filename of report.
HL7 EMR Flag Delete: When is checked, previous report with flag delete Y is sending
before send the actual report.

ADT MESSAGES

The Server ED receives a HL7 message from the EMR system:
Action to follow according to the message:

A0l Admit/Visit notification(Register Inpatient). A04 Register a patient(Register
Outpatient).A08 Update patient information. A31 Update person information. When
messages arrives check FP# and FA# in server patient database, if not exist is created
or updated if exist.

Any other messages are unimplemented and ignored by Server ED.

The Endodigi shall obtain the Patient Demographic information from the ADT
messages, specifically the PID and PV1 segments.
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ADT | General Order Message Chapter in HL7 V2.4
MSH Message Header 2
EVN Event Type 3
PID Patient Identification 3
PV1 Patient Visit 3
ALl Patient Allergy Information 3

SEGMENTS MESSAGE

MSH Segment
This segment is common to all messages Profile (or at least only vary slightly).
The message header (MSH) contains information about the sending and receiving
applications of messages, version and the unique identifier of the message required for
error control itself.

SE | LE | DT | OP | ELEMENT NAME | OBSERVATION/ENDODIGI
Q |N T USE
1 1 ST R Field Separator "
2 4 ST R Encoding N~\&
Characters n
1. Component ~
2. Repeat \
3. Escape &
4. Subcomponent
3 180 |HD (R Sending Name of the sending
Application application.
4 180 | HD [ R Sending Facility Name of the sending facility.
5 180 |HD | O Receiving Name of receiving application
Application
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6 180 |HD | O Receiving Facility | Name of receiving facility
7 26 [ TS R Date/Time Of Date and time the message
Message was created.
YYYYMMDDHHMMISS][+/
-2777]
20110602161633+1100
9 13 |CM |[R Message Type ADT”A01/02/03/04/08/12/31
1.Message type
2.Trigger event
10 (20 | ST R Message Control This field contains a number
ID or other identifier that
uniquely identifies the
message. The receiving
system echoes this 1D back to
the sending system in the
Message acknowledgment
segment
The sending system must
assign an identifier for the
message that is unique within
the namespace of the sending
facility.
€g.815200312322600
11 (3 PT R Processing ID P
12 |60 |VID [R Version ID 24
Event Type Segment
SE |LE | DT | OPT | ELEMENT NAME | OBSERVATION/ENDODIGI
Q N USE
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1 3 ID R Event Type Code A01/02/03/04/08/12/31

2 26 TS R Recorded Date and | YYYYMMDDHHMMISS][+/
Time -2777]

PID Segment
This segment is common to others messages Profile (or at least only vary slightly).

SE |LE |DT |OP | ELEMENT OBSERVATION/ENDODIGI USE
Q |N T | NAME

2 20 |CX |B Patient ID

3 20 |CX |R Patient Identifier | Medical Record Number (#FP)

List The unique medical record number
of the patient's chart within the
system.

Eg. 123456
5 48 XP | R Patient Name Last name and first name are
N 1. Last Name required.
2. First Name
3. Middle Initial

FirstName: XPN.2(<given name
(ST)> ) XPN.3 (<second and
further given names or initials
thereof (ST)>)

LastName: XPN.1.1(<surname
(ST)>)

Eg. Smith~John"D

7 26 TS R Date/Time of DOB: YYYYMMDDhhmmss
Birth Give the year, month, and day of
birth (YYYYMMDD).

Endodigi ignore any time
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component in the birth date.

Eg. 19730704000000

8 1 IS Sex Gender:
A Ambiguous
F Female
M Male
N Not applicable
O Other
U Unknown
11 106 | XA Patient Address | Street: XAD.1.1 (<street or mailing
D 1. Address Line | address (ST)>) XAD.1.2 ( <street
1 name (ST)>) XAD.2 (<other
2. Address Line | designation (ST)>Field for
2 additional information: block,
3. City staircase, floor door.)
4. State
5. Postal Code Street Num: XAD.1.3
(DwellingNumber)
City: XAD.3 (<city (ST)>)
State:XAD.4 (<state or province
(ST)>
)
Postal Code: XAD.5 (<zip or postal
code (ST)>)
13 250 | XT Phone Number - | Telephone:XTN.1 ( [NNN]
N Home [(999)1999-9999 [X99999]
[B99999] [C any text])
Email:XTN.4(<email address (ST)>)
18 30 | CX Patient Account | Visit Name (#FA)
Number
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PV1 Segment

This segment is common to others messages Profile (or at least only vary slightly).

SE | LEN DT | OP | ELEMENT OBSERVATION/ENDODIGI
Q T NAME USE
7 60 XC | O Attending doctor
N 1. Last Name Eg. Smith"John"D
2. First Name
3. Middle Initial This information could be
autopopulate in Visit Report
8 60 XC | O Referring doctor Eg. Smith"John"D
N 1. Last Name This information could be
2. First Name autopopulate in Visit Report
3. Middle Initial
17 | 250 XC | O Admitting Doctor | Eg. Smith~John"D
N 1. Last Name This information could be
2. First Name autopopulate in Visit Report
3. Middle Initial
44 | 26 TS | O Admit Date/Time | YYYYMMDDHHMM[SS][+/
-2777]
20160602161633+1100
Visit Date
AL1 Segment

The AL1 segment contains patient allergy information.This information is displayed on
Endodigi Client patient form (read only) and will be available in Visit Report only for

future review.

All segments from all valid messages updates the Server Patient Database
(editable fields by EMR). If arrives a messages with null values of 'AL1" segment,
so the information in Server Patient Database (editable fields by EMR) is replaced
with NULL, no allergies. Check client ED Workflow

SE

LE

DT

OPT

ELEMENT NAME

OBSERVATION/ENDODIGI
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Q N USE
1 250 | CE Set ID- AL1 1.2,..
2 250 | CE Allergen Type Table 0127
Code
Value Description
DA Drug allergy
FA Food allergy
MA Miscellaneous
allergy
MC Miscellaneous
contraindicati
on
EA Environmental
Allergy
AA Animal
Allergy
PA Plant Allergy
LA Pollen
Allergy
3 250 | CE Allergen Code/
Mnemonic/ Eg. <identifier (ST)> " <text
Description (ST)>
1.1dentifier <00000741"OXYCODONE>
2.Text

Acknowledgments message details

ACK

Acknowledgments

Chapter in HL7
V2.4
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MSH Message Header 2
MSA Message Acknowledgment 2
MSH

This segment is described in “ADT message Details-MSH Segment” and only vary
slightly in ACK message.

MSA Segment
SE | LE | DT OPT | ELEMENT OBSERVATION/ENDODIGI
Q N NAME USE
1 2 ID R Acknowledgement | AA = Success

Code AE = Error
2 20 ST R Message Control €0.815200312322600

ID
3 80 ST (@] Text Message Success, or

Failure

6 100 | CE 0 Error Condition

Update of fields composed of more than one HL7 component

Ej. Endodigi Patient Name = PID 5.1 (Name) + PID 5.2 (Middle Name)

Endodigi
composed fields

HL7 Components

Patient Name

PID 5.1 Firstname +PID 5.2 Second Name

Attending Doctor

PV1.7.2 Last Name +PV1.7.3Firstname +PV1.7.4 MiddleName

Referring Doctor

PV1.8.2 Last Name +PV1.8.3Firstname +PV1.8.4 MiddleName

Admitting Doctor

PV1.17.2 Last Name +PV1.17.3Firstname +PV1.17 .4
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MiddleName

Alergies

All.1 + All.2 + .... all allergy segments

No partial editions are made. If either of the components presents content, then the
Endodigi field is completely replaced by the data sent in all the components.
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MAINTENANCE

To keep ENDODIGI in optimum working conditions, it is recommended to perform a
minor annual check.
This procedure shall include:

*  Cleanup.

»  Electrical connections inspection.
At the user’s request, the manufacturer will provide circuit schemes, component list,
technical descriptions and other documents related to those parts of the equipment that
can be repaired by duly qualified technical personnel.
All revision or maintenance works, repairs or modifications shall be written down on
the Maintenance Card of this manual, indicating the work performed, date, name and
signature of the responsible person that performed it

CLEANING THE CABINET

Use a soft dry cloth.

If the surfaces are very dirty, use a soft cloth slightly wet with alcohol. Avoid the
entrance of liquid to the unit

CD CARE

Clean it with a soft cloth that does not leave lint to clean the stains, dust or digital
imprints. Always clean from the center outwards.

Then put it away and remember that the software is part of the device. Do not leave the
disk in wet places or with hot temperatures and do not expose it directly to sunlight

ELECTRICAL CONNECTIONS
Constantly check the condition of all components and their aging process. Verify that
the following does not exist:

e  Cables in bad condition, broken or cut.

e  Faulty connections between the cable and the plug.

e  Oxide corrosion in connecting pins.
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MAINTENANCE CARD

This card shall only be completed by authorized personnel from the company,
responsible for the maintenance, repair and modification of the device

We recommend keeping it updated for a faster and more efficient service

Work Performed

Person

Date

Signature
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TROUBLESHOOTING

GENERAL CONSIDERATIONS

Verify that the ENDODIGI is turned on. When you starting the video or image records,
checking if the light shine.
If you are using USB extensions or your equipment is connected through a HUBs USB,
probably this is causing the inconveniencies. Try connecting the equipment directly to
the original ports on the PC mother.
Also, the PC front ports may cause trouble due to the internal lay up to the mother,
which generally does not meet the specifications for USB Hi-Speed devices. Therefore,
it is emphatically recommended to connect the equipment on the rear ports of the PC.

A\

Any problems first try disabling the firewall and then check if the
problem persists.

PROBLEM

PROBABLECAUSE

ACTION

No video appears on
the screen or video is
defective

ENDODIGI is not
properly connected to

Simply plug the USB cable into a free

the PCoritis USB 2.0porton your system. Don’t
connected to a front use HUBs or extension cords.
port.
The_U_SB cord or plug Contact the technical service
in is damaged.

The video standard is
not the correct one.

Change it by pressing the Control
button from the video/image capture
screen.

The image quality is
poor.

Change the Brightness, Color

(saturation) etc. by pressing the

Control button from the image
capture screen.

The video input is
wrong.

Select the input being used
(Composite or S-Video) by pressing
the Input button from the image
capture screen.

A message related to
video driver appears
before completing the
installation.

The driver is already
installed in your PC

Uninstall prior drivers from the
Windows Control Panel, then run
ENDODIGI software, go to Option
menu Digital Setup and reinstall it.
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ENDODIGIServer version

PROBLEM

CAUSE

ACTION

The device is not
detected by your PC.

ENDODIGI is not properly
connected to the PC or is
connected to a front port.

Simply plug the USB cable
into a free USB 2.0port on
your system. Do not use
HUBs or extension cords

The USB cord or plug in is
damaged.

Contact the technical
service

The drivers are not correctly
installed

Check that the equipment
drivers are correctly
installed.

See Drivers Installation.

It is not possible to
connect with the
server.

The Ethernet network is
disconnected

Make sure the network
Ethernet cable is plugged
into the PC client.

There isn’t server or server is
off

Verify if ENDODIGI is
running on the server you
are connected.

Wrong server settings

Check the settings in the
ENDODIGI server

The file transfer
process is too slow

Files are very large

Reduce file sizes.

The local network is
overloaded

The network is very busy,
wait a moment or ask with
your network administrator
about local network status.

The bandwidth was reduced

Consult with your network
administrator about local
traffic network rate.
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TECHNICAL SERVICE

ENDODIGI must be repaired and/or maintained exclusively in those facilities
authorized by ECLERIS. It recommends using the following procedures for a quicker
repair service and replacement of guarantee products.

1. Contact the technical department of your local distributor or the nearest
ECLERIS office.

2. Give detailed information of the problem.

3. If the problem cannot be solved by troubleshooting, the product must be sent
for its repair or replacement.

The following product information must be attached:
e  Owner’s name.
e Owner’s address.
e Contact name and phone number.
e  Product’s serial number.
e  Problem’s description.

4. Send the ENDODIGIfor repair or replacement. It must be sent in its original
packaging to avoid damages during transportation. ECLERIS shall not be
liable for those damages or defects that may occur during transportation,
caused by deficient packaging.
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WARRANTY

ECLERIS states that ENDODIGI has complied with the required Quality Control
verification and has no manufacturing defects, thus it guarantees the appropriate
functioning under adequate use in agreement with the indications stated in this manual.
The warranty period is one (1) year as from the date of purchase.

ECLERIS is not liable for any damage caused to/by ENDODIGI due to incorrect use,
negligence, incorrect cleaning or storage. Any repairs made by personnel not
authorized by ECLERIS will void the warranty. The described warranty is exclusively
valid for the original buyer

The following parts are excluded from the warranty:

e  Parts and components manufactured by third parties.

e Cables and plugs.

e  Damages resulting from connections to inadequate power supplies.

Disregarding the warranty situation, all shipment from and to the authorized technical
services of ECLERIS is the sole responsibility of the customer.
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RIGHTS

All rights arising from the manual herein, especially its reproduction, publishing and
translation are reserved. No part of this manual shall be reproduced by any means
(photocopy, microfilm or other methods) without the previous written authorization by
ECLERIS; likewise, no part shall be reproduced, multiplied or published through
electronic data processing.

The information contained in this manual can be modified or enlarged without previous
notification, without it representing any liability for ECLERIS.

Select the Crop Area tool in the Tools panel (circle or rectangle) and draw a crop area
around the figure
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